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Remarques importantes sur la manipulation et l’utilisation

• Cette machine est un appareil de précision.

• Installez la machine dans un endroit présentant la température et l’humidité relative spécifiées. Pour
plus d’informations, reportez-vous à la section Caractéristiques techniques(P. 346).

• Connectez la prise secteur, les câbles USB et Ethernet en toute sécurité.

• Lorsque vous déplacez la machine, soutenez toujours par le fond avec vos mains. Si la machine est
stockée ailleurs, elle risque d’être endommagée lors de son déplacement.

Lieu d’utilisation/espace d’utilisation

Installez la machine dans un endroit stable et de niveau.

N’installez jamais la machine dans l’un des endroits suivants. Cela peut entraîner une réduction de la qua-
lité ou un dysfonctionnement.

• Endroits soumis à de grandes fluctuations de température ou d’humidité

• Endroits sujets à des secousses ou des vibrations

• Endroits où le plancher est incliné, non nivelé ou instable

• Endroits poussiéreux

• Emplacements exposés à la lumière directe du soleil

• Emplacements situés à moins de 1 m d’un fort éclairage intérieur

• Emplacements à proximité d’équipements de climatisation ou de chauffage

• Endroits exposés à l’eau ou à l’air en mouvement

• Endroits exposés à un bruit électrique ou magnétique considérable ou à d’autres formes d’énergie
électromagnétique

 Important

DGSHAPE Corporation n’assume aucune responsabilité pour toute perte ou tout dommage de données ré-
sultant d’un dysfonctionnement ou d’un dommage informatique. (Toujours enregistrer les données impor-
tantes)

Assistance

Les informations d’assistance disponibles sur le site Web de DGSHAPE Corporation sont régulièrement mi-
ses à jour afin de constituer une référence utile en cas de problème. Avant de nous contacter, veuillez
vous référer aux informations figurant sur le site Seb ainsi que « Méthodes de dépannage ».

Notez que les URL contenues dans le présent manuel peuvent être modifiées sans préavis.

IMPORTANT

 LIENS CONNEXES 

・ https://www.rolanddg.co.jp/

Pour commencer

8  Renseignements de base

https://www.rolanddg.co.jp/


Unité principale de la machine de découpe

Avant

Num. Nom Aperçu des fonctions

Levier de chargement Utilisez ça lors du chargement du matériau.

Rouleau-pinceur gauche Soulevez le levier de chargement, puis pincez le matériau avec. Pla-
cez-le sur le bord gauche du matériau.

Chariot de coupe Installez le porte-lame. Il se déplace vers la gauche et la droite pour
couper le matériau.

Rouleau-pinceur droit Soulevez le levier de chargement, puis pincez le matériau avec. Pla-
cez-le sur le bord droit du matériau.

Rouleau abrasif Ce rouleau fait sortir le matériau vers l’avant ou l’arrière.

Grille abrasive Ceux-ci indiquent l’emplacement des rouleaux abrasifs. Lors du char-
gement du matériau, veillez à placer les rouleaux-pinceurs à l’inté-
rieur des zones indiquées par ces grilles.

Protecteur de lame Il protège la pointe de la lame pendant la coupe.

Ligne guide C’est un guide pour aligner le matériau lors du chargement.

Guide de la lame En insérant une lame, etc., et en la déplaçant le long du guide, il est
possible de couper le matériau sans le décharger.

Noms et fonctions des pièces
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Num. Nom Aperçu des fonctions

Panneau de commande Vous l’utilisez pour effectuer différentes opérations.

Noms et fonctions des pièces
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Arrière

Num. Nom Aperçu des fonctions

Connecteur USB Pour connecter un câble USB.

Fiche du cordon d’alimentation Pour alimenter la machine en électricité.

Connecteur Ethernet Pour brancher un câble Ethernet.

Ligne guide C’est un guide pour aligner le matériau lors du chargement.

Noms et fonctions des pièces
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Panneau de commande

▲
▲ ▲▲

Pièce Nom Détails Notation utilisée dans
le présent document

W:261mm
L:----  [0mm]  

Affichage Ceci affiche divers menus de réglage et d’au-
tres informations.

—

TEST Touche TEST Maintenez cette touche enfoncée pendant 1
seconde ou plus pour couper un modèle de
test pré-enregistré.

[TEST]

ORIGIN Touche ORIGIN Maintenez cette touche pendant une seconde
ou plus pour définir la position actuelle de la
lame comme origine.

[ORIGIN]

PAUSE Touche PAUSE Cela interrompt l’opération. Appuyez à nou-
veau sur cette touche pour relancer l’opéra-
tion.

[PAUSE]

▲
▲ ▲▲

Touches du curseur Utilisez ces touches pour déplacer le chariot
de coupe ou le matériau, ou pour sélectionner
ou régler les éléments du menu.

[▲] [▼] [◀] [▶]

MENU

Touche MENU Le message sur l’écran change chaque fois que
vous appuyez sur cette touche.

• Condition de coupe définie actuellement
• Mode menu
• Affichage de la largeur, ou affichage du ty-

pe de matériau

[MENU]

Noms et fonctions des pièces
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Pièce Nom Détails Notation utilisée dans
le présent document

FORCE Touche FORCE Cela affiche le menu de réglage de la force de
la lame.

[FORCE]

ENTER Touche ENTER Cette fonction est utilisée pour sélectionner
un élément de menu et pour finaliser un régla-
ge.

[ENTER]

PEN FORCE

Curseur PEN FORCE La force de la lame peut être configurée avec
précision. Vous pouvez même effectuer ce ré-
glage pendant que la coupe est en cours.

[PEN FORCE]

Bouton d’alimentation En appuyant sur cette touche, vous mettez la
machine sous tension, et cette touche s’allu-
me en bleu. Appuyez sur cette touche pendant
1 seconde ou plus pour mettre la machine hors
tension.

—

 LIENS CONNEXES 

・  P. 22 "CONDITION"

Noms et fonctions des pièces
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Lampe LED du chariot

Les états de la machine sont indiqués par les couleurs des lampes LED et leur mode d’éclairage.

État de la machine État de la LED

Mise hors tension de l’appareil

Désactivé

Mise sous tension

Allumée en bleu

Pendant le déverrouillage
(lorsque le levier de chargement est abaissé)

Allumée en bleu vif répété puis en bleu pâle

Pendant l’installation
(lorsque le levier de chargement est relevé)

Allumée en bleu pâle

Pendant la coupe

Allumée en bleu

En pause

Clignotement en bleu

Lorsqu’une anomalie se produit dans la machine

Clignotant en rouge

 LIENS CONNEXES 

・  P. 334 Messages d’erreur

Noms et fonctions des pièces
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Types de matériaux

Les deux principaux types de matériaux utilisés avec cette machine sont présentés ci-dessous.

• Matériau en rouleau

Média enroulé autour d’un tube de papier

• Matériau plat

Les médias ne sont pas enroulés sur un tube de papier comme les matériaux de format standard

Différents matériaux peuvent être choisis en fonction de vos besoins. Pour des informations détaillées sur
chaque matériau, contactez votre fournisseur de matériaux.

Dans ce manuel, les matériaux en rouleau et les matériaux plats peuvent être désignés collectivement par les termes
« média » ou « matériau ».

RAPPEL

Conditions des matériaux utilisables

Les conditions des matériaux qui peuvent être chargés dans la machine sont indiquées ci-dessous.

Taille

Largeur 50 à 700 mm

Longueur *1 100 mm ou plus (matériau plat)

Épaisseur du matériau à découper*2 0,3 mm ou moins (pour le chargement, jusqu’à 1,0 mm)

Poids de l’appareil Poids maximal du matériau en rouleau 5 kg

 

*1 Il n’y a pas de limite pour du matériau en rouleau

*2 Comprend l’épaisseur de la base papier (papier support)
 

Matériaux qui ne peuvent pas être utilisés

Sur cette machine, les matériaux avec une des caractéristiques suivantes ne peuvent pas être utilisés. Dé-
roulez et redressez la forme du matériau avant de le charger.

• Très déformé ou plié

• Les bords ne sont pas parallèles

Pour Imprimer et Couper, les matériaux suivants ne peuvent pas être utilisés en plus des matériaux men-
tionnés ci-dessus.

• Matériau transparent

• Matériau coloré

Pour l’impression et la découpe, utilisez un matériau blanc avec une base papier pouvant être imprimé avec une impri-
mante laser ou à jet d’encre. La détection automatique des repères de découpe peut ne pas être possible pour certains
matériaux, comme les matériaux laminés ou brillants.

• Types de matériaux pouvant être imprimés avec des imprimantes laser
Papier fin
Papier enduit

RAPPEL

Matériau utilisé
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Papier d’art
PET

• Types de matériaux pouvant être imprimés avec des imprimantes à jet d’encre
Papier fin
Papier enduit

Matériau utilisé
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Repères de découpe

Les repères de découpe sont utilisés pour l’alignement lors de la découpe du matériau, qui est imprimé à
partir de votre imprimante, sur cette machine. Le fait que la machine mémorise les positions des repères
de découpe, qui sont imprimés avec l’image, permet de corriger les positions de coupe.

Repères de découpe lisibles

Le capteur de la machine est capable uniquement de lire les repères de découpe comme le cercle illustré
ci-dessous.

• Diamètre : 10 mm

• Couleur : Noir

Il se peut que la machine ne puisse pas lire correctement les repères de découpe imprimés en fonction de l’encre d’im-
primante utilisée.

RAPPEL

Quand utiliser les repères de découpe [3] ou [4]

Utilisez normalement [4]. Comme [3] a moins de repères de découpe à lire que [4], le temps nécessaire à
la découpe est réduit. Cependant, le mode Outil n’est pas disponible avec [3].

 LIENS CONNEXES 

・  P. 342 Marges et distance entre les repères de découpe

Repères de découpe/Repères d’outils
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Repères d’outils

Les repères d’outils sont utilisés pour l’alignement manuel quand il n’est pas possible d’effectuer un ali-
gnement automatique à l’aide de repères de découpe.

Ils peuvent être imprimés autour des repères de découpe en utilisant CutStudio ou des plug-ins.

 LIENS CONNEXES 

・  P. 178 Imprimer et Couper en mode Outil

Repères de découpe/Repères d’outils
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Mise sous tension

Procédure

1. Appuyez sur le bouton d’alimentation.

La machine est mise sous tension et le voyant d’alimentation est allumé.

Mise hors tension de l’appareil

Procédure

1. Maintenez le bouton d’alimentation enfoncé pendant une seconde ou plus.

L’alimentation est coupée.

2. Abaissez le levier de chargement et retirez le matériau.

Lorsque vous n’utilisez pas la machine, gardez le levier de chargement abaissé, même si elle est
sous tension.

 LIENS CONNEXES 

・  P. 302 L’alimentation ne peut pas être coupée

Opérations relatives à l’alimentation électrique
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Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez plusieurs fois sur [▲][▼] pour afficher le menu que vous voulez vérifier.

Les menus qui peuvent être affichés sont présentés ci-dessous.

Cliquez sur [▶] dans chaque menu pour vérifier les informations détaillées ou pour modifier le pa-
ramètre.

UNSETUP
"DECHARGER"
Ce message apparaît lorsque le matériau est chargé. En appuyant sur [ENTER], le
matériau est désactivé.

CONDITION
"CONDITION"
Configurez les conditions de coupe, notamment la force de la lame et la vitesse
de coupe. Les réglages affectent la qualité de la coupe. Modifiez les conditions
de coupe en fonction du matériau que vous utilisez.

P. 22"CONDITION"

SYSTEM INFO.
"INFO. SYSTEME"
Vérifiez les informations du système, notamment la version du firmware,
l’adresse IP et le masque de sous-réseau.

P. 24"INFO. SYSTEME"

CROPMARK
<SENSOR MODE>

"CROPMARK"
Définissez la méthode d’alignement lors de la découpe du matériau sur lequel
sont imprimés des repères de découpe ou des repères d’outils. Utilisez normale-
ment "SENSOR MODE".

OTHERS
"AUTRES"
Vous pouvez configurer l’affichage, ou activer ou désactiver d’autres paramè-
tres.

P. 25"AUTRES"

REPLOT
<DATA EXISTS>

"RETRACER"
Les données reçues de l’ordinateur peuvent être enregistrées dans la mémoire
de la machine, et ces données peuvent ensuite être utilisées à plusieurs reprises
pour couper (recouper).

P. 229Couper les mêmes données à répétition

MEMORY
<USER1>

"MEMOIRE"
Pour économiser le temps passé à définir les conditions de coupe à chaque chan-
gement de matériau, vous pouvez enregistrer les conditions de coupe des maté-
riaux fréquemment utilisés dans la mémoire de la machine.

P. 232Enregistrement des conditions de coupe fréquem-
ment utilisées

Vérification du menu d’affichage
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 LIENS CONNEXES 

・  P. 178 Imprimer et Couper en mode Outil

・  P. 182 Imprimer et Couper en mode manuel

・  P. 198 Optimiser la qualité et l’efficacité

"CONDITION"

Ici, les conditions de coupe, notamment la force de la lame et la vitesse de coupe, sont réglées et confir-
mées. Les réglages affectent la qualité de la coupe. Modifiez les conditions de coupe en fonction du maté-
riau que vous utilisez.

• "PRESSION"

FORCE 50gf

La force de la lame peut être configurée. Si le modèle se décolle ou si la base papier est aussi cou-
pée avec le matériau, modifiez le réglage de "PRESSION". 

P. 203Configuration de la force de la lame

• "VITESSE"

SPEED 40cm/s

La vitesse de coupe peut être configurée. Si la ligne de coupe est déformée ou s’il reste des zones
non coupées, modifiez le réglage de "VITESSE". 

P. 205Configuration de la vitesse de coupe

• "LAME"

OFFSET 0.250mm

Le décalage de la pointe de la lame peut être configuré. Si le début d’une coupe dévie de l’empla-
cement prévu ou si les coins d’une forme ne sont pas nets, modifiez le réglage de "LAME". 

P. 206Réglage du décalage de la pointe de la lame

• "VIT MAX"

UPSPEED 40cm/

Il est possible de régler la vitesse à laquelle la lame se soulève du matériau et se déplace vers la
position de coupe suivante pendant l’opération de coupe. Quand vous découpez un matériau plus
fin ou plus épais que le matériau standard, modifiez le réglage de "VIT MAX" pour éviter des problè-
mes comme le soulèvement du matériau.

P. 212Réglage de la vitesse de la lame pendant la coupe

• "ROTAT."

ROTATE 0deg A

Les coordonnées de coupe peuvent être pivotées, et la direction de coupe du matériau peut être
configurée.

P. 208Définir l’orientation des coordonnées de coupe

• "QUALITE"

Vérification du menu d’affichage
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QUALITY NORMAL

La qualité de la coupe peut être configurée. En cas d’utilisation d’un matériau épais, modifiez le
réglage de "QUALITE".

• "EXTENSION"

EXTEND 0.0mm

Vous pouvez choisir d’agrandir ou non la zone de coupe par rapport au réglage normal. Pour optimi-
ser l’utilisation du matériau, modifiez le réglage de "EXTENSION".

P. 210Extension de la zone de coupe

• "AIRE"

AREA 1.0m

En cas d’utilisation de matériau en rouleau, la longueur du matériau requis peut être configurée.
Lors de la mise en place du matériau en rouleau, modifiez le réglage de "AIRE".

P. 403.  Vérifier l’alimentation en matériaux

Vérification du menu d’affichage

Fonctionnement de base 23



"INFO. SYSTEME"

Vérifiez les informations du système, notamment la version du firmware, l’adresse IP et le masque de
sous-réseau.

• "MODELE"

SYSTEM INFO.
MODEL

Le nom du modèle peut être vérifié.

• "SERIAL NO."

SYSTEM INFO.
SERIAL No.

Le numéro de série peut être vérifié.

• "FIRMWARE"

SYSTEM INFO.
FIRMWARE

La version du firmware peut être vérifiée.

• "INTERFACE"

SYSTEM INFO.
INTERFACE

Le paramètre de connexion avec l’ordinateur peut être vérifié.

Pour vérifier les paramètres réseau comme l’adresse IP, appuyez deux fois sur [▶], utilisez [▼]
pour sélectionner les informations à afficher, puis appuyez sur [▶].

Vérification du menu d’affichage
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"AUTRES"

Vous pouvez configurer l’affichage, ou activer ou désactiver d’autres paramètres.

• "LISSAGE"

SMOOTHING ON

Vous pouvez régler les courbes des données de découpe envoyées à cette machine pour qu’elles
soient lissées.

P. 213Découpage en douceur des arcs et autres courbes (Lissage)

• "UNITES"

UNIT mm

Vous pouvez définir l’unité pour l’affichage.

P. 276Modification de l’unité de longueur à afficher

• "PARAM. DEFAUT"

FACTORYDEFAULT

Cette procédure ramène tous les paramètres à leurs valeurs d’usine par défaut. Tout réglage effec-
tué jusqu’à ce point sera supprimé. Conservez un registre de toutes les informations nécessaires,
notamment les conditions de coupe.

P. 279Restauration des paramètres par défaut

• "CONTRASTE"

CONTRAST 5

Vous pouvez régler la luminosité de l’écran. Modifiez le réglage pour faciliter votre lecture de
l’écran en fonction de votre environnement.

P. 278Réglage de la luminosité de l’écran

• "ASPIRATION"

VACUUMFAN AUTO

Mettez en marche le ventilateur aspirant pour maintenir le matériau en place pendant la coupe
pour éviter que le matériau ne se soulève ou ne se déplace. Lors de l’utilisation de matériaux fins
et/ou peu solides, il est recommandé de réduire le volume d’air du ventilateur aspirant.

P. 218Utilisation d’un matériau plus fin ou plus dur que la normale

• "PRE-DEFIL"

PRE-FEED OFF

Le matériau est alimenté automatiquement avant et pendant la coupe pour éviter tout problème
d’alignement des positions de coupe. Ce paramètre est particulièrement utile lors de la découpe
de données de 1 m ou plus.

P. 220Prévention des coupes mal alignées

• "OVER CUT"

Vérification du menu d’affichage
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OVER CUT OFF

Cette fonction coupe ce qui est en trop au début et à la fin d’une ligne de coupe. Elle est efficace
quand vous souhaitez obtenir des angles particulièrement nets, par exemple lors de la découpe de
matériaux plus épais.

P. 216Couper les coins proprement (Surcoupe)

• "SUPERPOSITION"

OVERLAP OFF

La coupe est répétée plusieurs fois à la même position avec les mêmes données de coupe. Utilisez
ce paramètre pour les matériaux qui ne peuvent pas être coupés en un seul passage, comme les
matériaux épais.

P. 214Couper à la même position de façon répétitive (Superposition)

• "PERFORER"

PERFORATE OFF

La coupe perforée peut être utilisée pour découper des matériaux sans base papier ou pour faire
des plis sur les données de coupe. La zone de coupe est séparée après la coupe pour éviter que le
matériau ne se coince.

P. 235Séparation ultérieure de la zone de coupe

• "CROP ADJ."

CROP ADJ.

Si les positions d’impression et de coupe ne sont pas alignées, vous pouvez corriger le problème en
ajustant la position d’impression ou la position de coupe.

P. 222Ajustement de la position de coupe

P. 224Ajustement de la position d’impression

Vérification du menu d’affichage
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Position de chargement du matériau

Chargez le matériau de façon à ce que les marges gauche et droite soient uniformes des bords du matériau
aux rouleaux-pinceurs. Chargez le matériau de façon à ce que le rouleau-pinceur (W) se trouve dans la
plage (Y) de la partie abrasive (X).

Selon la largeur du matériau à charger, les marges gauche et droite peuvent ne pas être uniformes, et la marge sur le
bord droit du matériau peut être plus grande que la marge sur le bord gauche.

RAPPEL

Z Position d’utilisation du rouleau-pinceur gauche

Plage d’utilisation du rouleau-pinceur gauche
Lors du chargement d’un matériau dont la largeur est différente de A à D, déplacez le rouleau-pinceur gau-
che.

Plage d’utilisation du rouleau-pinceur droit avec le matériau A chargé

Plage d’utilisation du rouleau-pinceur droit avec le matériau B chargé

Plage d’utilisation du rouleau-pinceur droit avec le matériau C chargé

Plage d’utilisation du rouleau-pinceur droit avec le matériau D chargé

A Matériau d’une largeur d’environ 150 mm

B Matériau d’une largeur d’environ 306 mm

C Matériau d’une largeur d’environ 457 mm

D Matériau d’une largeur d’environ 610 mm

Mise en place du matériau
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Lorsque vous chargez un matériau autre que ceux décrits ci-dessus, modifiez la position du rouleau-pin-
ceur gauche pour l’adapter à la largeur du matériau.

 LIENS CONNEXES 

・  P. 9 Avant

Mise en place du matériau
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Mise en place du matériau plat

Si un matériau plat est utilisé, il doit être au moins 70 mm plus long que la taille verticale des données de
coupe. C’est la longueur nécessaire pour que le rouleau abrasif évacue le matériau vers l’avant ou l’arriè-
re.

Reportez-vous à la figure ci-dessous et assurez-vous que les marges sont suffisantes à l’avant et à l’arrière,
à droite et à gauche du matériau.

50 mm ou plus

15 mm ou plus

25 mm ou plus

Les matériaux avec une des caractéristiques suivantes ne peuvent pas être utilisés : Déroulez et redressez la forme du
matériau avant de le charger.

• Le matériau est enroulé vers le haut.
• Le bord d’attaque du matériau est plié ou froissé.

IMPORTANT

1. Chargement du matériau plat

Ces instructions décrivent comment installer du matériau A4.

Procédure

1. Abaissez le levier de chargement.

N’utilisez pas une force excessive lorsque vous déplacez le levier de chargement.
Vous risqueriez de l’endommager.

IMPORTANT

Mise en place du matériau
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2. Insérez le matériau par l’avant de la machine.

3. Placez le matériau dans la position indiquée sur la figure ci-dessous.

La position de réglage diffère en fonction de la taille du matériau à charger.

4. Déplacez les rouleaux-pinceurs vers les bords du matériau de manière à ce que chacun d’entre eux se
trouve à l’intérieur des parties abrasives.

Placez le matériau de façon à ce que les marges gauche et droite ( ) entre les bords du matériau
et les rouleaux-pinceurs soient uniformes.

Mise en place du matériau
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Lorsque vous utilisez un matériau avec une grande quantité à alimenter (matériau long), réglez les marges
gauche et droite sur environ 25 mm.

RAPPEL

Le matériau perforé alimenté par des pignons possède des perforations le long de chaque bord pour permettre
son alimentation. Si les rouleaux-pinceurs sont positionnés au-dessus des perforations, le matériau ne peut pas
être alimenté correctement. Lorsque vous utilisez ce matériau avec la machine, placez les rouleaux-pinceurs
loin des perforations.

RAPPEL

5. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

6. Relevez le levier de chargement.

Le matériau est fixé à sa place.

Mise en place du matériau
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Utilisez le lien suivant pour visionner une vidéo de référence pour cette procédure.
Chargement du matériau plat

RAPPEL

 LIENS CONNEXES 

・  P. 15 Conditions des matériaux utilisables

・  P. 27 Position de chargement du matériau

・  P. 341 Zone de découpe

Mise en place du matériau
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2. Vérifier le matériau chargé

Procédure

1. Mettez la machine en marche.

2. Appuyez plusieurs fois sur [▼] pour sélectionner "FEUILLE".

SELECT SHEET
*PIECE

3. Appuyez sur [ENTER].

Le chariot de coupe se déplace vers la position du rouleau-pinceur gauche, et le matériau avance
et recule.

Lorsque l’initialisation se termine, la largeur et la longueur de la découpe sont affichées sur
l’écran.

W:***mm
L:***mm

4. Après l’arrêt de l’opération, vérifiez les éléments suivants.

• Le bord gauche du matériau n’est pas incliné vers la ligne guide

• Les rouleaux-pinceurs ne sont pas décalés par rapport au matériau

Vue du dessus de la machine

Mise en place du matériau
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RAPPEL
Quand le matériau est incliné ou quand les rouleaux-pinceurs sont décalés par rapport au maté-
riau, ce dernier ne peut pas être mis en place correctement. Effectuez la procédure suivante, et
recommencez la configuration du matériau depuis le début.

a. Sortez le matériau et remettez le chariot de coupe en position d’attente.

P. 173Retrait du matériau

b. Appuyez sur le bouton d’alimentation pendant 1 seconde ou plus pour mettre la machine hors
tension.

5. Appuyez sur [MENU].

Assurez-vous que les valeurs des éléments sont affichées.

La valeur de la figure suivante est un exemple de référence.

20cm/s
250gf 0.250mm ∠A
20cm/s
250gf 0.250mm ∠A

Vitesse de découpe

Force de la lame

Décalage de la pointe de la lame

Orientation des coordonnées de coupe

Si un matériau plat de plus de 1,6 m est chargé, la machine le reconnaît comme un rouleau.
Si c’est le cas, faites avancer le matériau et confirmez que le matériau peut être alimenté normalement.
Si vous démarrez la découpe sans confirmer l’alimentation du matériau, il risque de glisser pendant la décou-
pe, ou la qualité de la découpe pourra être dégradée à cause d’une alimentation incorrecte.

P. 403.  Vérifier l’alimentation en matériaux

IMPORTANT

 LIENS CONNEXES 

・  P. 203 Configuration de la force de la lame

・  P. 206 Réglage du décalage de la pointe de la lame

・  P. 208 Définir l’orientation des coordonnées de coupe

・  P. 205 Configuration de la vitesse de coupe

Mise en place du matériau
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Mise en place du matériau en rouleau

Si vous n’utilisez pas la base du rouleau, coupez d’abord la quantité nécessaire pour la découpe du rouleau et chargez-
le comme un matériau plat.

P. 29Mise en place du matériau plat

RAPPEL

1. Chargement du matériau en rouleau

Chargez le matériau en rouleau dans la machine en utilisant la base du rouleau.

Article requis

Base du rouleau

Charger correctement le média en rouleau.
Sinon, le média risque de tomber et de provoquer des blessures.

ATTENTION

Le média en rouleau pèse environ 5 kg.
Pour éviter les blessures, manipulez les médias en rouleau avec précaution.

ATTENTION

Ne chargez jamais un média pesant plus de 5 kg.
La machine peut ne pas médiaer un tel poids et se renverser, ou faire tomber le média.

ATTENTION

Procédure

1. Vérifiez que le levier de chargement est abaissé.

Mise en place du matériau
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2. Installez la base du rouleau sur la machine.

Maintenez l’extrémité de la machine lorsque vous la soulevez.

3. Placez le matériau en rouleau sur la base du rouleau.

Chargez le matériau en rouleau ( ) de sorte que les parties (A) s’étendant au-delà des bords gau-
che et droit de la base du rouleau ( ) soient uniformes.

Charger correctement le média en rouleau.
Sinon, le média risque de tomber et de provoquer des blessures.

ATTENTION

4. À partir du rouleau, tirez le matériau sur un peu plus de longueur que la quantité à utiliser, et insérez-le
de l’arrière vers l’avant de la machine.

Mise en place du matériau
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Laissez un peu de mou dans le matériau tiré. Si vous chargez le matériau sans donner de mou, le matériau ne
pourra pas être alimenté correctement.

IMPORTANT

5. Déplacez les rouleaux-pinceurs vers les bords du matériau et à l’intérieur des parties abrasives.

Positionnez les rouleaux-pinceurs de manière à ce que chacun se trouve à 25 mm ou plus ( ) vers
l’intérieur du bord gauche ou droit respectif du matériau.

Le matériau perforé alimenté par des pignons possède des perforations le long de chaque bord pour permettre
son alimentation. Si les rouleaux-pinceurs sont positionnés au-dessus des perforations, le matériau ne peut pas
être alimenté correctement. Lorsque vous utilisez ce matériau avec la machine, placez les rouleaux-pinceurs
loin des perforations.

RAPPEL

Mise en place du matériau
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6. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

7. Relevez le levier de chargement.

Le matériau est fixé à sa place.

Utilisez le lien suivant pour visionner une vidéo de référence pour cette procédure.
Chargement du matériau en rouleau

RAPPEL

 LIENS CONNEXES 

・  P. 15 Conditions des matériaux utilisables

・  P. 27 Position de chargement du matériau

Mise en place du matériau
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2. Sélectionner le type de matériau

Sélectionnez le type de matériau à charger dans la machine.

Procédure

1. Mettez la machine en marche.

L’écran illustré dans la figure suivante s’affiche.

SELECT SHEET
ROLL

2. Appuyez sur [▲] ou [▼] pour sélectionner "ROULEAU" ou "BORD".

Si "BORD" est sélectionné et configuré, environ 15 mm ( ) du bord supérieur du matériau sont ré-
servés pour la marge. Si
"ROULEAU" est sélectionné et configuré, aucune marge n’est réservée.

3. Appuyez sur [ENTER].

Le chariot de coupe se déplace vers le bord gauche. La largeur de coupe apparaît alors à l’écran.

W:261mm
L:----  [0mm]

 LIENS CONNEXES 

・  P. 35 Chargement du matériau en rouleau

Mise en place du matériau
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3. Vérifier l’alimentation en matériaux

Avant de couper, faites avancer le matériau et confirmez que le matériau peut être alimenté normale-
ment.

Si vous démarrez la découpe sans confirmer l’alimentation du matériau, il risque de glisser pendant la dé-
coupe, ou la qualité de la découpe pourra être dégradée à cause d’une alimentation incorrecte.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼] pour afficher l’écran suivant.

CONDITION

3. Appuyez sur [▶], puis [▲] pour afficher l’écran illustré ci-dessous.

L’écran illustré dans la figure ci-dessous s’affiche.

AREA 1.0m

4. Appuyez sur [▶].

5. Appuyez sur [▲][▼] pour configurer la longueur de matériau requise pour les données de coupe.

Pour que le rouleau abrasif puisse faire avancer le matériau, il faut laisser des marges au début et
à la fin de la zone de coupe. Il est judicieux de définir une valeur supérieure d’environ 0,2 m à la
longueur de matériau requise.

AREA 1.0m
*-24.9m

6. Appuyez sur [ENTER].

La longueur définie du matériau avance, puis est immédiatement ramenée et reprise.

Si le matériau glisse des rouleaux-pinceurs, appuyez sur [PAUSE] pour arrêter le fonctionnement.
Abaissez le levier de chargement, sortez le matériau et recommencez le réglage depuis le début.

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

 LIENS CONNEXES 

・  P. 15 Matériau utilisé

・  P. 29 Chargement du matériau plat

・  P. 35 Chargement du matériau en rouleau

Mise en place du matériau
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Étape 1: Préparer la lame

Ne jamais toucher l’extrémité du couteau.
Vous risqueriez de vous blesser. La performance de coupe de la lame sera également altérée.

ATTENTION

Articles requis (articles inclus)

Porte-lame Lame Broche *1

 

*1 La broche est insérée dans le support.
 

Procédure

1. Si la broche a été retirée du porte-lame, insérez-la.

2. Tournez le captop du porte-lame dans le sens horaire, et serrez-le jusqu’à ce qu’il cesse de tourner.

3. Insérez la lame.

Préparatifs en vue de la coupe
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Les conditions de coupe, comme la profondeur, la vitesse de coupe, la force de la lame, etc., doivent être
ajustées en fonction du type de matériau.
Veillez à effectuer des tests de découpe avec le matériau à utiliser et à ajuster les conditions de coupe.

IMPORTANT

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 201 Réglage du paramètre de coupe

Préparatifs en vue de la coupe
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Étape 2: Installez le porte-lame

Ne jamais toucher l’extrémité du couteau.
Vous risqueriez de vous blesser. La performance de coupe de la lame sera également altérée.

ATTENTION

Procédure

1. Desserrez la vis du chariot de coupe.

2. Insérez le porte-lame.

Confirmez que le porte-lame et le chariot de coupe sont engagés.

3. Serrez fermement la vis du chariot de coupe.

Préparatifs en vue de la coupe
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Utilisez le lien suivant pour visionner une vidéo de référence pour cette procédure.
Préparation de la lame

RAPPEL
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Étape 3: Réaliser un test de découpe

Ajustez les conditions de coupe en fonction des types de matériaux et de la netteté de la coupe. Pour ob-
tenir des résultats de découpe de haute qualité, effectuez un test de découpe pour vérifier la qualité de la
coupe du matériau avant d’effectuer la coupe proprement dite.

Procédure

1. Vérifiez que le curseur PEN FORCE est en position centrale (au « 0 » sur l’échelle).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Appuyez sur [▲][▼][◀][▶] pour déplacer le chariot de coupe.

Déplacez le chariot de coupe de manière à ce que la pointe de la lame soit orientée vers la posi-
tion de départ de la coupe.

Pour déplacer rapidement le matériau ou le chariot de coupe, appuyez sur [ENTER] et sur l’une des touches
[▲][▼][◀][▶] lorsque l’un des écrans suivants s’affiche.

20cm/s
250gf 0.250mm ∠A

W:***mm
L:***mm

RAPPEL

3. Maintenez la touche [TEST] enfoncée pendant une seconde ou plus.

La découpe du modèle de test commencera à l’emplacement de la lame quand vous avez appuyé
sur [TEST].

4. Une fois la découpe terminée, appuyez sur [▼] pour faire avancer le matériau.

Préparatifs en vue de la coupe
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▲
▲ ▲▲

5. Décollez la forme découpée avec une pince à épiler, etc. pour vérifier la qualité de la découpe.

Les conditions suivantes sont des signes de bonne qualité.

• Quand la partie circulaire est décollée, seule la partie circulaire se détache

• Quand la partie carrée est décollée, une légère trace de lame est laissée sur la base papier

Si l’une des conditions suivantes est présente, réglez la force de la lame ou la vitesse de coupe.
Après le réglage, effectuez à nouveau un test de découpe. Répétez ce processus jusqu’à ce que
vous obteniez une bonne qualité.

Vérifiez l’article Résultat Élément de régla-
ge

Ajustement

Vérifiez la forme. La forme de la coupe est déformée. Vitesse de décou-
pe

Réduire

Décollez le cercle. Les autres formes se détachent ensem-
ble

Force de la lame Augmentez la for-
ce

La base papier est également coupée Réduire

Il reste quelques zones non coupées. Vitesse de décou-
pe

Réduire

Décollez le carré. La trace de la lame n’est pas visible Force de la lame Augmentez la for-
ce

La trace de la lame est trop profonde Réduire

En cas d’utilisation d’un matériau dur ou d’une base papier fine, la modification de la force de la lame peut
ne pas permettre d’obtenir une bonne qualité. Ajustez la longueur d’extension de la pointe de la lame, et
ajustez précisément la profondeur de coupe.

IMPORTANT

Utilisez le lien suivant pour visionner une vidéo de référence pour cette procédure.
Test de coupe

RAPPEL
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 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 203 Configuration de la force de la lame

・  P. 205 Configuration de la vitesse de coupe

・  P. 201 Ajustement de la profondeur de coupe

Préparatifs en vue de la coupe

Fonctionnement de base 47



Étape 4: Configuration de l’emplacement de départ de l’impression

Avant la découpe, réglez l’emplacement de départ de l’impression à un endroit où une zone de découpe
adaptée peut être sécurisée.

Sortez la découpe réelle sur une zone qui ne chevauche pas la zone utilisée pour les tests de découpe.

Procédure

1. Appuyez sur [◀][▲] pour déplacer le chariot de coupe à l’endroit que vous voulez définir comme origi-
ne.

Déplacez le chariot de coupe jusqu’à ce que la pointe de la lame soit orientée vers l’endroit que
vous voulez définir comme origine.

2. Appuyez sur [▲] pour faire reculer le matériau, et assurez-vous que les traces de test de découpe se
trouvent devant le protecteur de lame.

La lame se déplace sur le protecteur de lame. Lorsque l’origine est définie, la zone située derrière
le protecteur de lame est définie comme zone de coupe.

3. Maintenez la touche [ORIGIN] enfoncée pendant une seconde ou plus.

L’affichage clignote, et l’emplacement de la pointe de la lame est défini comme origine.

Préparatifs en vue de la coupe

48  Fonctionnement de base



Méthode d’impression

49



Création de données de cou-
pe avec CutStudio

Méthode de coupe......................................................................................51
Étape 1:  Création de données de découpe ..................................................51
Étape 2:  Réglage des conditions de coupe ..................................................57
Étape 3:  Découpe................................................................................61

Méthode d’impression et de découpe ...............................................................62
Étape 1:  Créer des données d’impression et de coupe....................................62
Étape 2:  Définir les conditions d’impression................................................67
Étape 3:  Générer les données d’impression et de coupe .................................71
Étape 4:  Configurer le réglage pour effectuer un alignement automatique ...........77
Étape 5:  Réglage des conditions de coupe ..................................................78
Étape 6:  Découpe................................................................................82

Méthodes avancées de création de données .......................................................84
Modification du noircissement de l’image placée...........................................84
Changement pour des polices verticales .....................................................86
Déplacement d’un symbole enregistré sur un nouvel ordinateur.........................88

50  Création de données de coupe avec CutStudio



Étape 1: Création de données de découpe

Saisissez du texte et des formes, et créez des données de coupe. Cette section explique comment créer
des données de coupe contenant des « SALE », et comment ajouter une « ligne de séparation », qui facilite
le décollage ultérieur.

Procédure

1. Lancez CutStudio.

• Windows 11

a. Cliquez sur [Start].

b. Cliquez sur [Toutes les applications]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Cliquez sur [Start].

b. Cliquez sur [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Cliquez sur  en bas à gauche de la fenêtre [Start] pour afficher la fenêtre [Apps].

b. Cliquez sur .

CutStudio démarre.

2. Cliquez sur .

3. Cliquez n’importe où, puis saisissez « SALE ».

Méthode de coupe

Création de données de coupe avec CutStudio 51



4. Cliquez sur , et modifiez la taille des caractères.

 et  apparaissent autour du texte.Faites glisser  ou  pour modifier la taille du texte.

Pour spécifier la taille du texte en utilisant des valeurs, sélectionnez l’objet cible et cliquez sur .

RAPPEL

5. Cliquez sur [Object]>[Weed].

La fenêtre [Weed] s’affiche.

Méthode de coupe
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6. Cochez la case [Weed Border], puis cliquez sur [OK].

Une ligne pour éliminer les chutes est ajoutée autour des lettres.

Méthode de coupe

Création de données de coupe avec CutStudio 53



L’objet saisi est regroupé avec sa ligne de séparation. Pour plus de détails sur les lignes de sépara-
tion, consultez l’aide de CutStudio.

Méthode de coupe
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7. Cliquez sur un objet, puis cliquez sur .

L’objet se déplace vers l’origine.

L’origine affichée sur CutStudio indique la position de départ de la sortie du matériau chargé.
Le positionnement de l’objet par rapport à l’origine permet d’éviter une alimentation excessive du matériau.

RAPPEL

8. Cliquez sur .

Méthode de coupe
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9. Sélectionnez le dossier dans lequel vous souhaitez enregistrer les données, saisissez le nom du fichier,
puis cliquez sur [Save].

Les données que vous avez créées sont enregistrées.

Méthode de coupe
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Étape 2: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

3. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

4. Cliquez sur [Change] sous [Media Size].

Méthode de coupe
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5. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

6. Cliquez sur [OK].

Méthode de coupe
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

7. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

8. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Étape 3: Découpe

Envoyez les données de coupe à la machine, et coupez le matériau.

Si le matériau sort mal ou si la machine fonctionne anormalement, appuyez sur [PAUSE] pour annuler la sortie.
Abaissez le levier de chargement, sortez le matériau et recommencez le réglage depuis le début.

IMPORTANT

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

La découpe commence.

 LIENS CONNEXES 

・  P. 176 Pause et annulation de l’impression

・  P. 27 Mise en place du matériau

Méthode de coupe
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Étape 1: Créer des données d’impression et de coupe

1. Placer les données d’impression

CutStudio ne peut lire que les types de fichiers suivants.

• Format JPEG (les fichiers JPEG enregistrés au format CMYK ne peuvent pas être lus)
• Format PNG
• Format BMP
• Formats AI et EPS (version Illustrator 8.0 uniquement. Si vous utilisez une version supérieure, changez pour une ver-

sion antérieure de la sauvegarde)

RAPPEL

Procédure

1. Lancez CutStudio.

• Windows 11

a. Cliquez sur [Start].

b. Cliquez sur [Toutes les applications]>[Roland CutStudio]>[CutStudio].

• Windows 10

a. Cliquez sur [Start].

b. Cliquez sur [Roland CutStudio]>[CutStudio].

• Windows 8.1

a. Cliquez sur  en bas à gauche de la fenêtre [Start] pour afficher la fenêtre [Apps].

b. Cliquez sur .

CutStudio démarre.

2. Sélectionnez [File]>[Print&Cut] sur CutStudio.

La zone d’impression et les repères de découpe s’affichent à l’écran. La zone d’impression est af-
fichée en pointillés. Des repères de découpe seront affichés dans la zone où les marges spécifiées
dans [Printing Setup] sont exclues de la taille du matériau spécifiée dans [Set up the printer].

Méthode d’impression et de découpe
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3. Cliquez sur  pour importer des données d’impression.

Ici, Sample.bmp trouvé dans le dossier d’installation de CutStudio (normalement situé dans le dos-
sier [Program Files (x86)]>[CutStudio] du lecteur C) est ouvert comme données d’impression.

4. Sélectionnez les données d’impression, puis cliquez sur [Open].

Méthode d’impression et de découpe
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5. Positionnez les données d’impression dans la zone située à l’intérieur des repères de découpe.

Vous pouvez modifier la densité de l’image importée.

 LIENS CONNEXES 

・  P. 84 Modification du noircissement de l’image placée

・  P. 331 Impossible d’importer les données auprès d’Illustrator

・  P. 332 Impossible de trouver les données échantillons

Méthode d’impression et de découpe
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2. Ajouter des lignes de coupe aux données d’impression

Ajouter des lignes de coupe aux données d’impression, qui sont lues dans CutStudio, et créer des données
d’impression et de coupe.

Procédure

1. Sélectionnez , et tracez les lignes de coupe.

Ici, une ligne de coupe est tracée autour des données d’impression comme indiqué ci-dessous ( ).

2. Cliquez sur .

3. Sélectionnez le dossier dans lequel vous souhaitez enregistrer les données, saisissez le nom du fichier,
puis cliquez sur [Save].

Les données d’impression et de coupe que vous avez créées sont enregistrées.

Méthode d’impression et de découpe
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Étape 2: Définir les conditions d’impression

Définissez la plage d’impression pour Imprimer et Couper ainsi que les repères de découpe.

Procédure

1. Cliquez sur [File]>[Printing Setup].

2. Cliquez sur [Set up the printer].

Méthode d’impression et de découpe
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3. Définissez le format du document, puis cliquez sur [OK].

4. Sélectionnez le nombre de repères de découpe.

Sélectionnez [4] ou [3] dans [Layout Points].

Méthode d’impression et de découpe
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[4] Repères de découpe : 4 points

[3] Repères de découpe : 3 points

Utilisez normalement [4].
Comme [3] a moins de repères de découpe à lire que [4], le temps nécessaire à la découpe est réduit, mais
cette fonction n’est pas disponible en mode Outil.

RAPPEL

5. Cliquez sur [Fit into shared area for cutting and printing].

L’emplacement du repère de découpe est défini automatiquement.

Méthode d’impression et de découpe
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Quand vous définissez manuellement les positions des repères de découpe, référez-vous au tableau ci-dessous
et spécifiez les marges et la distance entre les repères de découpe. Lorsque vous utilisez un matériau avec
une grande quantité à alimenter (matériau long), nous vous recommandons de régler les marges gauche et
droite sur environ 25 mm.

Marges et distances entre les repères de découpe sur différents formats de matériau avec 4 repè-
res de coupe (Unité : mm)

Élément de réglage A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 59 59 61 58 56

[Bottom] 20 20 20 20 20 20

[Left] 10 30 30 15 15 14

[Right] 10 16 16 14 16 14

[Crop
marks]

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

Marges et distances entre les repères de découpe sur différents formats de matériau avec 3 repè-
res de coupe (Unité : mm)

Élément de réglage A4 A3 B4

Y X Y X Y X

[Margins] [Top] 56 60 60 62 59 57

[Bottom] 20 20 20 20 20 20

[Left] 15 30 30 15 15 15

[Right] 15 17 17 15 17 14

[Crop
marks]

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

RAPPEL

6. Cliquez sur [OK].

Après avoir défini les valeurs, vérifiez que les repères de découpe se trouvent dans la zone d’im-
pression.

Si vous utilisez un matériau dont les dimensions sont supérieures à celles indiquées dans le tableau, définissez
les valeurs en vous référant à Marges et distance entre les repères de découpe(P. 342).

RAPPEL
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Étape 3: Générer les données d’impression et de coupe

1. Imprimer les données d’impression et de coupe

Envoyez des données d’impression de CutStudio à l’imprimante et imprimez les données d’impression et
de coupe.

Procédure

1. Chargez le matériau dans l’imprimante.

Pour savoir comment charger le matériau dans l’imprimante, consultez la documentation de l’im-
primante.

Lorsque l’impression agrandie/réduite est activée, désactivez-la. Veillez à imprimer avec une échelle de 100
%.

IMPORTANT

2. Cliquez sur .

La fenêtre [Print] s’affiche.

3. Sélectionnez l’imprimante que vous voulez utiliser, puis cliquez sur [OK].

Seules les données d’impression seront imprimées.

Méthode d’impression et de découpe
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2. Chargement du matériau imprimé

Chargez dans la machine le matériau imprimé à partir d’une imprimante.

Le matériau gondolé ne peut pas être utilisé, car les repères de découpe risquent de ne pas être lisibles. Si le matériau
se gondole lors de l’impression, redressez-le avant de le charger sur la machine.

IMPORTANT

Procédure

1. Vérifiez l’origine pour la découpe ( ) sur le matériau.

2. Réglez le matériau en positionnant son origine pour la coupe en bas à gauche de la machine.

Si le matériau est chargé dans le mauvais sens, la machine ne pourra pas lire les repères de découpe.

IMPORTANT

3. Positionnez les rouleaux-pinceurs.

Tenez compte des points suivants lors du positionnement des rouleaux-pinceurs.

• Positionner les rouleaux-pinceurs ( ) à l’extérieur des repères d’outils ( )

• S’assurer que les rouleaux-pinceurs ( ) sont réglés dans la plage des parties abrasives ( )

Méthode d’impression et de découpe
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Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous
utilisez du matériau dans des formats autres que A3, A4 ou B4.

• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins
30 mm (W) entre l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de déga-
gement est inférieure à 30 mm, le repère de découpe ne peut pas être lu.

RAPPEL

4. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

5. Relevez le levier de chargement.

Le matériau est fixé à sa place.

Méthode d’impression et de découpe
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6. Mettez la machine en marche.

7. Sélectionnez [FEUILLE] comme type de matériau.

8. Appuyez sur [ENTER].

La largeur et la longueur de la découpe sont affichées.

W:***mm
L:***mm

9. Appuyez sur [▲][▼] pour déplacer le matériau et positionner le repère de découpe ( ) au-dessus du
protecteur de lame ( ).

Les repères de découpe ne peuvent pas être lus dans les situations indiquées ci-dessous. Retirez le matériau
une fois, puis rechargez-le.

• Les repères de découpe sont séparés du protecteur de lame ( ) par une distance de 15 mm ou plus ( )
• Les repères de découpe gauche et droit sont inclinés de 5 degrés ou plus ( ) par rapport au sens de dépla-

cement du chariot de coupe
• Les repères de découpe gauche et droit s’écartent de 20 mm ou plus ( ) dans le sens d’alimentation du

matériau

IMPORTANT
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10. Appuyez sur [◀][▶] pour déplacer le chariot de coupe de façon à ce que la pointe de la lame vienne se
placer au milieu du repère de découpe inférieur gauche.
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Étape 4: Configurer le réglage pour effectuer un alignement automatique

Positionnez les repères de découpe automatiquement grâce au capteur intégré de la machine.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<TOOL MODE>

3. Appuyez sur [▶].

4. Appuyez sur [▲] ou [▼] pour sélectionner "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Appuyez sur [ENTER] pour sélectionner le paramètre.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.
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Étape 5: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

3. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

4. Cliquez sur [Change] sous [Media Size].
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5. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

6. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

7. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

8. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Étape 6: Découpe

Envoyez les données d’impression et de coupe à la machine, et démarrez la découpe.

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

Les données d’impression et de coupe sont envoyées à la machine. Quand la machine reçoit les
données d’impression et de coupe, elle lit automatiquement les repères de découpe avec un cap-
teur, puis démarre la coupe.

Si le capteur ne parvient pas à lire les repères de découpe, l’écran ci-dessous apparaît.

Si l’écran suivant apparaît, reportez-vous à la section Les repères de découpe ne sont pas détectés(P.
296) pour résoudre l’erreur.

SET TO
<TOOL MODE>

RAPPEL

Méthode d’impression et de découpe

82  Création de données de coupe avec CutStudio



Si cela ne résout pas le problème, passez en mode Outil, puis effectuez l’alignement. 

P. 178Imprimer et Couper en mode Outil

3. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau
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Cette section fournit des méthodes d’utilisation utiles pour créer des données en utilisant CutStudio.

Modification du noircissement de l’image placée

Vous pouvez modifier le noircissement d’une image importée dans CutStudio.

Procédure

1. Cliquez sur [File]>[Preference].

2. Configurez le paramètre [General]>[Image Darkness].

• Plage de réglages : 1 à 100 %
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3. Cliquez sur [OK].
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Changement pour des polices verticales

Cette procédure ne prend pas en charge les polices alphabétiques.

IMPORTANT

Procédure

1. Utilisez  pour sélectionner les caractères que vous voulez transformer en texte vertical.

2. Cliquez sur .

Le panneau s’ouvre.

3. Après avoir sélectionné le panneau [Format], cochez la case [Vertical writing font].

Le texte passe d’une écriture horizontale à une écriture verticale.
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Si vous souhaitez modifier l’orientation des caractères, utilisez [Angle of Rotation] sur le panneau [Size and
shape].

RAPPEL

4. Sélection des polices

Les polices japonaises qui prennent en charge l’écriture verticale apparaissent.
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Déplacement d’un symbole enregistré sur un nouvel ordinateur

Pour obtenir des instructions sur la manière d’enregistrer les symboles, consultez l’aide de CutStudio.

RAPPEL

Procédure

1. Copiez le dossier [Symbol] à partir du chemin ci-dessous.

• C:\ProgramData\Roland DG Corporation\CutStudio\Symbol

Si le dossier n’est pas affiché, vérifiez le paramètre d’affichage des fichiers cachés.

P. 332Impossible de trouver les données échantillons

RAPPEL

2. Copiez le dossier [Symbol] sur le nouvel ordinateur.

Copiez le dossier au même endroit sur le nouvel ordinateur.
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Création de données de cou-
pe avec Adobe Illustrator
(Windows)
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Cette section décrit comment créer des données de coupe avec Adobe Illustrator et comment effectuer la
découpe.

Pour sortir les données de coupe créées avec Adobe Illustrator vers CutStudio, il faut installer le plug-in
CutStudio pour Adobe Illustrator.

Pour obtenir des informations sur les dernières versions prises en charge, visitez le site Web de DGSHAPE
Corporation (https://www.rolanddg.co.jp/).

 LIENS CONNEXES 

・ GS2-24 Installation and Initial Settings Windows Version

Étape 1: Création de données de découpe

Saisissez du texte et des formes, et créez des données de coupe. Cette section explique comment créer
des données de coupe avec Adobe Illustrator 2020. La procédure d’opération est la même pour les autres
versions.

Procédure

1. Lancez Adobe Illustrator.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.
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3. Créez un nouveau document.

Configurez la taille du document sur l’une des tailles de découpe qui s’affichent sur l’écran de la
machine après la configuration du matériau.

4. Saisissez du texte et des formes.

Dans cet exemple, nous saisissons « SALE » et nous traçons une ligne autour du mot, appelée « li-
gne de séparation », qui permet de supprimer facilement les données de coupe.

Mettez en valeur le texte. En choisissant du texte et en cliquant sur  dans la palette [Roland CutStudio],
le texte est mis en valeur.

RAPPEL
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Étape 2: Sortir les données de coupe vers CutStudio

Vous pouvez transmettre à CutStudio les données des lignes de coupe réalisées avec Adobe Illustrator.

Procédure

1. Sélectionnez [Output All Lines] sur la palette [Roland CutStudio].

2. Cochez la case [Auto Update] dans la palette.

Un aperçu de l’objet à éditer s’affiche.

3. Cliquez sur .

CutStudio démarre, et les données de la ligne de coupe sont envoyées à CutStudio.

Les données de sortie sont toujours alignées à l’origine de CutStudio, quelle que soit leur position sur Adobe
Illustrator. (Cela ne s’applique pas aux données avec des repères de découpe.)

RAPPEL
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Étape 3: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

3. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

4. Cliquez sur [Change] sous [Media Size].

Méthode de coupe
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5. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

6. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

7. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

8. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Étape 4: Découpe

Envoyez les données de coupe à la machine, et coupez le matériau.

Si le matériau sort mal ou si la machine fonctionne anormalement, appuyez sur [PAUSE] pour annuler la sortie.
Abaissez le levier de chargement, sortez le matériau et recommencez le réglage depuis le début.

IMPORTANT

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

La découpe commence.

 LIENS CONNEXES 

・  P. 27 Mise en place du matériau
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Vérification de l’aide d’Adobe Illustrator

Procédure

1. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.

2. Sur la palette, cliquez sur .

3. Cliquez sur [Help].
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Étape 1: Définir les conditions d’impression

Définissez la plage d’impression pour Imprimer et Couper ainsi que les repères de découpe.

Procédure

1. Lancez Adobe Illustrator, puis ouvrez un nouveau document.

Configurez le panneau.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.
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3. Sur la palette, cliquez sur .

Les repères de découpe sont insérés dans le panneau.

4. Cliquez sur  sur la palette, puis sur [Crop-marks].

5. Configurez le [Type], [Point].

Pour [Type], sélectionnez « GS2-24 ».

[Point] indique le nombre de repères de découpe.

Quand [Point] est « 4 » Repères de découpe : 4 points

Quand [Point] est « 3 » Repères de découpe : 3 points

Normalement, sélectionnez « 4 » dans [Point]. Quand [Point] est « 3 », le mode Outil n’est pas
disponible.

6. Définissez la marge et la distance entre les repères de découpe, puis cliquez sur [OK].

Pour plus de détails concernant les marges et la distance entre les repères de découpe, consultez
le tableau ci-dessous. Lorsque vous utilisez un matériau avec une grande quantité à alimenter (ma-
tériau long), nous vous recommandons de régler les marges gauche et droite sur environ 25 mm.
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Marges et distances entre les repères de découpe sur différents formats de matériau avec 4 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Marges et distances entre les repères de découpe sur différents formats de matériau avec 3 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si vous utilisez un matériau dont les dimensions sont supérieures à celles indiquées ci-dessus, définissez les
valeurs en vous référant à Marges et distance entre les repères de découpe(P. 342).

RAPPEL

Les repères de découpe sont affichés sur le panneau.
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Étape 2: Créer des données d’impression et de coupe

1. Placer les données d’impression

Procédure

1. Cliquez sur [File]>[Placement] pour importer les données d’impression.

Ici, Sample.bmp trouvé dans le dossier d’installation de CutStudio (normalement situé dans le dos-
sier [Program Files (x86)]>[CutStudio] du lecteur C) est ouvert comme données d’impression.

2. Sélectionnez les données d’impression, puis cliquez sur [Layout Points].

3. Positionnez les données d’impression dans la zone située à l’intérieur des repères de découpe.
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2. Ajouter des lignes de coupe aux données d’impression

Ajoutez des lignes de coupe aux données d’impression positionnées, et créez des données d’impression et
de coupe.

Procédure

1. Créez une nouvelle couche pour les lignes de coupe et dessinez-y les lignes de coupe.

Ici, une ligne de coupe est tracée autour des données d’impression comme indiqué ci-dessous ( ).

2. Cliquez sur [File]>[Save].

3. Sélectionnez le dossier dans lequel vous souhaitez enregistrer les données, saisissez le nom du fichier,
puis cliquez sur [Save].

Les données d’impression et de coupe que vous avez créées sont enregistrées.
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Étape 3: Générer les données d’impression et de coupe

1. Imprimer les données d’impression et de coupe

Envoyez les données d’impression à l’imprimante et imprimez les données d’impression et de coupe.

Procédure

1. Chargez le matériau dans l’imprimante.

Pour savoir comment charger le matériau dans l’imprimante, consultez la documentation de l’im-
primante.

Lorsque l’impression agrandie/réduite est activée, désactivez-la. Veillez à imprimer avec une échelle de 100
%.

IMPORTANT

2. Masquez la couche contenant les lignes de coupe.

3. Cliquez sur [File]>[Print].

4. Vérifiez la configuration de l’impression, puis cliquez sur [Print].

Seules les données d’impression seront imprimées.
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2. Chargement du matériau imprimé

Chargez dans la machine le matériau imprimé à partir d’une imprimante.

Le matériau gondolé ne peut pas être utilisé, car les repères de découpe risquent de ne pas être lisibles. Si le matériau
se gondole lors de l’impression, redressez-le avant de le charger sur la machine.

IMPORTANT

Procédure

1. Vérifiez l’origine pour la découpe ( ) sur le matériau.

2. Réglez le matériau en positionnant son origine pour la coupe en bas à gauche de la machine.

Si le matériau est chargé dans le mauvais sens, la machine ne pourra pas lire les repères de découpe.

IMPORTANT

3. Positionnez les rouleaux-pinceurs.

Tenez compte des points suivants lors du positionnement des rouleaux-pinceurs.

• Positionner les rouleaux-pinceurs ( ) à l’extérieur des repères d’outils ( )

• S’assurer que les rouleaux-pinceurs ( ) sont réglés dans la plage des parties abrasives ( )
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Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous
utilisez du matériau dans des formats autres que A3, A4 ou B4.

• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins
30 mm (W) entre l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de déga-
gement est inférieure à 30 mm, le repère de découpe ne peut pas être lu.

RAPPEL

4. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

5. Relevez le levier de chargement.

Le matériau est fixé à sa place.

Méthode d’impression et de découpe

Création de données de coupe avec Adobe Illustrator (Windows) 109



6. Mettez la machine en marche.

7. Sélectionnez [FEUILLE] comme type de matériau.

8. Appuyez sur [ENTER].

La largeur et la longueur de la découpe sont affichées.

W:***mm
L:***mm

9. Appuyez sur [▲][▼] pour déplacer le matériau et positionner le repère de découpe ( ) au-dessus du
protecteur de lame ( ).

Les repères de découpe ne peuvent pas être lus dans les situations indiquées ci-dessous. Retirez le matériau
une fois, puis rechargez-le.

• Les repères de découpe sont séparés du protecteur de lame ( ) par une distance de 15 mm ou plus ( )
• Les repères de découpe gauche et droit sont inclinés de 5 degrés ou plus ( ) par rapport au sens de dépla-

cement du chariot de coupe
• Les repères de découpe gauche et droit s’écartent de 20 mm ou plus ( ) dans le sens d’alimentation du

matériau

IMPORTANT

Méthode d’impression et de découpe

110  Création de données de coupe avec Adobe Illustrator (Windows)



10. Appuyez sur [◀][▶] pour déplacer le chariot de coupe de façon à ce que la pointe de la lame vienne se
placer au milieu du repère de découpe inférieur gauche.
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Étape 4: Configurer le réglage pour effectuer un alignement automatique

Positionnez les repères de découpe automatiquement grâce au capteur intégré de la machine.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<TOOL MODE>

3. Appuyez sur [▶].

4. Appuyez sur [▲] ou [▼] pour sélectionner "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Appuyez sur [ENTER] pour sélectionner le paramètre.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.

Méthode d’impression et de découpe

112  Création de données de coupe avec Adobe Illustrator (Windows)



Étape 5: Envoyer des données d’impression et de coupe vers CutStudio

Procédure

1. Affichez la couche contenant les lignes de coupe dessinées par Adobe Illustrator et sélectionnez-la.

2. Dans la palette [Roland CutStudio], sélectionnez [Output Current Layer], puis cliquez sur [Update].

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

3. Cliquez sur .

CutStudio démarre, et les données de la ligne de coupe sont envoyées à CutStudio.
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Étape 6: Réglage des conditions de coupe

Procédure

1. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

2. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

3. Cliquez sur [Change] sous [Media Size].
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4. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

5. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

6. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

7. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Méthode d’impression et de découpe
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Étape 7: Découpe

Envoyez les données d’impression et de coupe à la machine, et démarrez la découpe.

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

Les données d’impression et de coupe sont envoyées à la machine. Quand la machine reçoit les
données d’impression et de coupe, elle lit automatiquement les repères de découpe avec un cap-
teur, puis démarre la coupe.

Si le capteur ne parvient pas à lire les repères de découpe, l’écran ci-dessous apparaît.

Si l’écran suivant apparaît, reportez-vous à la section Les repères de découpe ne sont pas détectés(P.
296) pour résoudre l’erreur.

Si cela ne résout pas le problème, passez en mode Outil, puis effectuez l’alignement.

P. 178Imprimer et Couper en mode Outil

RAPPEL
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SET TO
<TOOL MODE>

3. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau
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Cette section décrit comment créer des données de coupe avec Adobe Illustrator et comment effectuer la
découpe.

Pour sortir les données de coupe créées avec Adobe Illustrator, il faut installer le plug-in CutStudio pour
Adobe Illustrator.

Pour obtenir des informations sur les dernières versions prises en charge, visitez le site Web de DGSHAPE
Corporation (https://www.rolanddg.co.jp/).

 LIENS CONNEXES 

・ GS2-24 Installation and Initial Settings For Macintosh Computers

Étape 1: Création de données de découpe

Saisissez du texte et des formes, et créez des données de coupe. Cette section explique comment créer
des données de coupe avec Adobe Illustrator 2020. La procédure d’opération est la même pour les autres
versions.

Procédure

1. Lancez Adobe Illustrator.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.
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3. Créez un nouveau document.

Configurez la taille du document sur l’une des tailles de découpe qui s’affichent sur l’écran de la
machine après la configuration du matériau.

4. Saisissez du texte et des formes.

Dans cet exemple, nous saisissons « SALE » et nous traçons une ligne autour du mot, appelée « li-
gne de séparation », qui permet de supprimer facilement les données de coupe.

Mettez en valeur le texte.En choisissant du texte et en cliquant sur  dans la palette [Roland CutStudio], le
texte est mis en valeur.

RAPPEL
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Méthode de coupe
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Étape 2: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Dans le panneau [Roland CutStudio], sélectionnez [GS2-24] dans [Model].

3. Dans le panneau, cliquez sur [Update Information].

La plage de découpe est récupérée à partir de la machine connectée, et l’affichage sur [Media]
sera mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

4. Cliquez sur  sur la palette, puis sur [Preferences].

5. Cochez la case [Use Cut Setting].

Méthode de coupe
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6. Cliquez sur [OK].

7. Cliquez sur  sur la palette, puis sur [Cut Setting].

[Cut Setting] apparaît en sélectionnant [Cut Setting].

8. Définissez les conditions de coupe.

Normalement, la case [Use Machine Setting] est cochée.

Pour modifier la condition de coupe, décochez [Use Machine Setting] et saisissez les valeurs.

9. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.
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Étape 3: Découpe

Envoyez les données de coupe à la machine, et coupez le matériau.

Si le matériau sort mal ou si la machine fonctionne anormalement, appuyez sur [PAUSE] pour annuler la sortie.
Abaissez le levier de chargement, sortez le matériau et recommencez le réglage depuis le début.

IMPORTANT

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Dans la palette [Roland CutStudio], sélectionnez [Output All Lines], puis cliquez sur [Update].

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

2. Sur la palette, cliquez sur .

3. Sélectionnez [Roland GS2-24], et cliquez sur [Cut].

La découpe commence.

Si le nom du modèle n’apparaît pas, reportez-vous à la section La machine ne fonctionne pas.

4. Une fois la découpe terminée, cliquez sur [Exit] pour fermer la fenêtre.
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Étape 1: Définir les conditions d’impression

Définissez la plage d’impression pour Imprimer et Couper ainsi que les repères de découpe.

Procédure

1. Lancez Adobe Illustrator, puis ouvrez un nouveau document.

Configurez le panneau.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.

3. Sur la palette, cliquez sur .

Les repères de découpe sont insérés dans le panneau.

4. Cliquez sur  sur la palette, puis sur [Crop-marks].
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5. Configurez le [Type], [Point].

Pour [Type], sélectionnez « GS2-24 ».

[Point] indique le nombre de repères de découpe.

Quand [Point] est « 4 » Repères de découpe : 4 points

Quand [Point] est « 3 » Repères de découpe : 3 points

Normalement, sélectionnez « 4 » dans [Point]. Quand [Point] est « 3 », le mode Outil n’est pas
disponible.

6. Définissez la marge et la distance entre les repères de découpe, puis cliquez sur [OK].

Pour plus de détails concernant les marges et la distance entre les repères de découpe, consultez
le tableau ci-dessous. Lorsque vous utilisez un matériau avec une grande quantité à alimenter (ma-
tériau long), nous vous recommandons de régler les marges gauche et droite sur environ 25 mm.

Marges et distances entre les repères de découpe sur différents formats de matériau avec 4 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20
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Marges et distances entre les repères de découpe sur différents formats de matériau avec 3 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si vous utilisez un matériau dont les dimensions sont supérieures à celles indiquées ci-dessus, définissez les
valeurs en vous référant à Marges et distance entre les repères de découpe(P. 342).

RAPPEL

Les repères de découpe sont affichés sur le panneau.
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Étape 2: Créer des données d’impression et de coupe

1. Placer les données d’impression

Procédure

1. Cliquez sur [File]>[Placement] pour importer les données d’impression.

2. Positionnez les données d’impression dans la zone située à l’intérieur des repères de découpe.
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2. Ajouter des lignes de coupe aux données d’impression

Ajoutez des lignes de coupe aux données d’impression positionnées, et créez des données d’impression et
de coupe.

Procédure

1. Créez une nouvelle couche pour les lignes de coupe et dessinez-y les lignes de coupe.

Ici, une ligne de coupe est tracée autour des données d’impression comme indiqué ci-dessous ( ).

2. Cliquez sur [File]>[Save].

3. Sélectionnez le dossier dans lequel vous souhaitez enregistrer les données, saisissez le nom du fichier,
puis cliquez sur [Save].

Les données d’impression et de coupe que vous avez créées sont enregistrées.
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Étape 3: Générer les données d’impression et de coupe

1. Imprimer les données d’impression et de coupe

Envoyez les données d’impression à l’imprimante et imprimez les données d’impression et de coupe.

Procédure

1. Chargez le matériau dans l’imprimante.

Pour savoir comment charger le matériau dans l’imprimante, consultez la documentation de l’im-
primante.

Lorsque l’impression agrandie/réduite est activée, désactivez-la. Veillez à imprimer avec une échelle de 100
%.

IMPORTANT

2. Masquez la couche contenant les lignes de coupe.

3. Cliquez sur [File]>[Print].

4. Vérifiez la configuration de l’impression, puis cliquez sur [Print].

Seules les données d’impression seront imprimées.
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2. Chargement du matériau imprimé

Chargez dans la machine le matériau imprimé à partir d’une imprimante.

Le matériau gondolé ne peut pas être utilisé, car les repères de découpe risquent de ne pas être lisibles. Si le matériau
se gondole lors de l’impression, redressez-le avant de le charger sur la machine.

IMPORTANT

Procédure

1. Vérifiez l’origine pour la découpe ( ) sur le matériau.

2. Réglez le matériau en positionnant son origine pour la coupe en bas à gauche de la machine.

Si le matériau est chargé dans le mauvais sens, la machine ne pourra pas lire les repères de découpe.

IMPORTANT

3. Positionnez les rouleaux-pinceurs.

Tenez compte des points suivants lors du positionnement des rouleaux-pinceurs.

• Positionner les rouleaux-pinceurs ( ) à l’extérieur des repères d’outils ( )

• S’assurer que les rouleaux-pinceurs ( ) sont réglés dans la plage des parties abrasives ( )
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Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous
utilisez du matériau dans des formats autres que A3, A4 ou B4.

• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins
30 mm (W) entre l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de déga-
gement est inférieure à 30 mm, le repère de découpe ne peut pas être lu.

RAPPEL

4. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

5. Relevez le levier de chargement.

Le matériau est fixé à sa place.
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6. Mettez la machine en marche.

7. Sélectionnez [FEUILLE] comme type de matériau.

8. Appuyez sur [ENTER].

La largeur et la longueur de la découpe sont affichées.

W:***mm
L:***mm

9. Appuyez sur [▲][▼] pour déplacer le matériau et positionner le repère de découpe ( ) au-dessus du
protecteur de lame ( ).

Les repères de découpe ne peuvent pas être lus dans les situations indiquées ci-dessous. Retirez le matériau
une fois, puis rechargez-le.

• Les repères de découpe sont séparés du protecteur de lame ( ) par une distance de 15 mm ou plus ( )
• Les repères de découpe gauche et droit sont inclinés de 5 degrés ou plus ( ) par rapport au sens de dépla-

cement du chariot de coupe
• Les repères de découpe gauche et droit s’écartent de 20 mm ou plus ( ) dans le sens d’alimentation du

matériau

IMPORTANT
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10. Appuyez sur [◀][▶] pour déplacer le chariot de coupe de façon à ce que la pointe de la lame vienne se
placer au milieu du repère de découpe inférieur gauche.
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Étape 4: Configurer le réglage pour effectuer un alignement automatique

Positionnez les repères de découpe automatiquement grâce au capteur intégré de la machine.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<TOOL MODE>

3. Appuyez sur [▶].

4. Appuyez sur [▲] ou [▼] pour sélectionner "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Appuyez sur [ENTER] pour sélectionner le paramètre.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.
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Étape 5: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Dans le panneau [Roland CutStudio], sélectionnez [GS2-24] dans [Model].

3. Dans le panneau, cliquez sur [Update Information].

La plage de découpe est récupérée à partir de la machine connectée, et l’affichage sur [Media]
sera mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

4. Cliquez sur  sur la palette, puis sur [Preferences].

5. Cochez la case [Use Cut Setting].
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6. Cliquez sur [OK].

7. Cliquez sur  sur la palette, puis sur [Cut Setting].

[Cut Setting] apparaît en sélectionnant [Cut Setting].

8. Définissez les conditions de coupe.

Normalement, la case [Use Machine Setting] est cochée.

Pour modifier la condition de coupe, décochez [Use Machine Setting] et saisissez les valeurs.

9. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.
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Étape 6: Découpe

Envoyez les données à la machine, et commencez à couper le matériau.

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Affichez la couche contenant les lignes de coupe et sélectionnez-la.

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

2. Sélectionnez [Output Current Layer].

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

Pour modifier ou vérifier le paramètre de coupe, reportez-vous à la section Étape 2: Réglage des
conditions de coupe.

3. Sur la palette, cliquez sur .

4. Sélectionnez [Roland GS2-24], et cliquez sur [Cut].
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Les données de coupe sont envoyées à la machine. Lorsque la machine reçoit les données, elle lit
automatiquement les repères de découpe avec un capteur, puis commence à couper.

Si le nom du modèle n’apparaît pas, reportez-vous à la section La machine ne fonctionne pas.

RAPPEL

Si le capteur ne parvient pas à lire les repères de découpe, l’écran ci-dessous apparaît.

Si l’écran suivant apparaît, reportez-vous à la section Les repères de découpe ne sont pas détectés
pour résoudre l’erreur.

SET TO
<TOOL MODE>

Si cela ne résout pas le problème, passez en mode Outil, puis effectuez l’alignement. 

P. 178Imprimer et Couper en mode Outil

RAPPEL

5. Une fois la découpe terminée, cliquez sur [Exit] pour fermer la fenêtre.

6. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau
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Cette section décrit comment créer des données de coupe avec CorelDRAW et comment effectuer la dé-
coupe.

Pour sortir les données de coupe créées avec CorelDRAW vers CutStudio, il faut installer le plug-in CutStu-
dio pour CorelDRAW.

Pour obtenir des informations sur les dernières versions prises en charge, visitez le site Web de DGSHAPE
Corporation (https://www.rolanddg.co.jp/).

 LIENS CONNEXES 

・ GS2-24 Installation and Initial Settings Windows Version

Étape 1: Création de données de découpe

Saisissez du texte et des formes, et créez des données de coupe. Cette section explique comment créer
des données de coupe avec CorelDRAW 2020. La procédure d’opération est la même pour les autres ver-
sions.

Procédure

1. Lancez CorelDRAW.

2. Dans la barre d’outils, cliquez sur .

La palette [Roland CutStudio] apparaît.

3. Créez un nouveau document.

Configurez la taille du document sur l’une des tailles de découpe qui s’affichent sur l’écran de la
machine après la configuration du matériau.

4. Saisissez du texte et des formes.

Dans cet exemple, nous saisissons « SALE » et nous traçons une ligne autour du mot, appelée « li-
gne de séparation », qui permet de supprimer facilement les données de coupe.
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Mettez en valeur le texte.En choisissant du texte et en cliquant sur  dans la palette [Roland CutStudio],
le texte est mis en valeur.

RAPPEL
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Étape 2: Sortir les données de coupe vers CutStudio

Envoyez les données de coupe créées sur CorelDRAW à CutStudio.

Procédure

1. Sélectionnez [Output All Lines] sur la palette [Roland CutStudio].

2. Cochez la case [Auto Update].

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

3. Cliquez sur .

CutStudio démarre, et les données de la ligne de coupe sont envoyées à CutStudio.

Les données de sortie sont toujours alignées à l’origine de CutStudio, quelle que soit leur position sur Corel-
DRAW.

RAPPEL
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Les données créées sur CorelDRAW sont transmises à CutStudio dans les conditions suivantes.

• Tous les graphiques qui sont dessinés sont envoyés à CutStudio.
• Les chaînes de caractères ne sont pas envoyées à CutStudio. Mettez-les en forme avant de les sortir.
• La largeur de ligne, le remplissage et les flèches sont ignorés.
• Les lignes sans largeur ne sont pas sorties.
• Les images ne sont pas sorties.

RAPPEL
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Étape 3: Réglage des conditions de coupe

Procédure

1. Vérifiez que le matériau a été correctement chargé et mis en place.

P. 27Mise en place du matériau

2. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

3. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

4. Cliquez sur [Change] sous [Media Size].
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5. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

6. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

7. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

8. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Étape 4: Découpe

Envoyez les données de coupe à la machine, et coupez le matériau.

Si le matériau sort mal ou si la machine fonctionne anormalement, appuyez sur [PAUSE] pour annuler la sortie.
Abaissez le levier de chargement, sortez le matériau et recommencez le réglage depuis le début.

IMPORTANT

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

La découpe commence.

 LIENS CONNEXES 

・  P. 27 Mise en place du matériau
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Vérification l’aide de CorelDRAW

Procédure

1. Dans la barre d’outils, cliquez sur .

La palette [Roland CutStudio] apparaît.

2. Sur la palette, cliquez sur .

3. Cliquez sur [Help].
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Étape 1: Définir les conditions d’impression

Définissez la plage d’impression pour Imprimer et Couper ainsi que les repères de découpe.

Procédure

1. Démarrez CorelDRAW, puis ouvrez un nouveau document.

Définissez le format du document.

2. Dans la barre d’outils, cliquez sur .

La palette [Roland CutStudio] apparaît.

3. Sur la palette, cliquez sur .

Des repères de découpe sont insérés dans le document.
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4. Cliquez sur  sur la palette, puis sur [Crop-marks].

5. Configurez le [Type], [Point].

Pour [Type], sélectionnez « GS2-24 ».

[Point] indique le nombre de repères de découpe.

Quand [Point] est « 4 » Repères de découpe : 4 points

Quand [Point] est « 3 » Repères de découpe : 3 points
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Normalement, sélectionnez « 4 » dans [Point]. Quand [Point] est « 3 », le mode Outil n’est pas
disponible.

6. Définissez la marge et la distance entre les repères de découpe, puis cliquez sur [OK].

Pour plus de détails concernant les marges et la distance entre les repères de découpe, consultez
le tableau ci-dessous. Lorsque vous utilisez un matériau avec une grande quantité à alimenter (ma-
tériau long), nous vous recommandons de régler les marges gauche et droite sur environ 25 mm.

Marges et distances entre les repères de découpe sur différents formats de matériau avec 4 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 230 230 370 205 315

[L] 200 110 320 195 265 160

[X] 10 30 30 15 15 15

[Y] 20 20 20 20 20 20

Marges et distances entre les repères de découpe sur différents formats de matériau avec 3 repères de
coupe (Unité : mm)

A4 A3 B4

Y X Y X Y X

[W] 170 240 240 380 215 325

[L] 210 120 330 205 275 170

[X] 15 30 30 15 15 15

[Y] 20 20 20 20 20 20

Si vous utilisez un matériau dont les dimensions sont supérieures à celles indiquées ci-dessus, définissez les
valeurs en vous référant à Marges et distance entre les repères de découpe(P. 342).

RAPPEL

Les repères de découpe sont affichés sur le panneau.
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Étape 2: Créer des données d’impression et de coupe

1. Placer les données d’impression

Procédure

1. Cliquez sur [File]>[Import] pour importer les données d’impression.

Ici, Sample.bmp trouvé dans le dossier d’installation de CutStudio (normalement situé dans le dos-
sier [Program Files (x86)]>[CutStudio] du lecteur C) est ouvert comme données d’impression.

2. Sélectionnez les données d’impression, puis cliquez sur [Import].

3. Positionnez les données d’impression dans la zone située à l’intérieur des repères de découpe.
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2. Ajouter des lignes de coupe aux données d’impression

Ajoutez des lignes de coupe aux données d’impression positionnées, et créez des données d’impression et
de coupe.

Procédure

1. Créez une nouvelle couche pour les lignes de coupe et dessinez-y les lignes de coupe.

Ici, une ligne de coupe est tracée autour des données d’impression comme indiqué ci-dessous ( ).

2. Cliquez sur [File]>[Save].

3. Sélectionnez le dossier dans lequel vous souhaitez enregistrer les données, saisissez le nom du fichier,
puis cliquez sur [Save].

Les données d’impression et de coupe que vous avez créées sont enregistrées.
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Étape 3: Générer les données d’impression et de coupe

1. Imprimer les données d’impression et de coupe

Envoyez les données d’impression à l’imprimante et imprimez les données d’impression et de coupe.

Procédure

1. Chargez le matériau dans l’imprimante.

Pour savoir comment charger le matériau dans l’imprimante, consultez la documentation de l’im-
primante.

Lorsque l’impression agrandie/réduite est activée, désactivez-la. Veillez à imprimer avec une échelle de 100
%.

IMPORTANT

2. Masquez la couche contenant les lignes de coupe.

3. Cliquez sur [File]>[Print].

4. Vérifiez la configuration de l’impression, puis cliquez sur [Print].

Seules les données d’impression seront imprimées.
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2. Chargement du matériau imprimé

Chargez dans la machine le matériau imprimé à partir d’une imprimante.

Le matériau gondolé ne peut pas être utilisé, car les repères de découpe risquent de ne pas être lisibles. Si le matériau
se gondole lors de l’impression, redressez-le avant de le charger sur la machine.

IMPORTANT

Procédure

1. Vérifiez l’origine pour la découpe ( ) sur le matériau.

2. Réglez le matériau en positionnant son origine pour la coupe en bas à gauche de la machine.

Si le matériau est chargé dans le mauvais sens, la machine ne pourra pas lire les repères de découpe.

IMPORTANT

3. Positionnez les rouleaux-pinceurs.

Tenez compte des points suivants lors du positionnement des rouleaux-pinceurs.

• Positionner les rouleaux-pinceurs ( ) à l’extérieur des repères d’outils ( )

• S’assurer que les rouleaux-pinceurs ( ) sont réglés dans la plage des parties abrasives ( )

Méthode d’impression et de découpe
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Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous
utilisez du matériau dans des formats autres que A3, A4 ou B4.

• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins
30 mm (W) entre l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de déga-
gement est inférieure à 30 mm, le repère de découpe ne peut pas être lu.

RAPPEL

4. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

5. Relevez le levier de chargement.

Le matériau est fixé à sa place.
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6. Mettez la machine en marche.

7. Sélectionnez [FEUILLE] comme type de matériau.

8. Appuyez sur [ENTER].

La largeur et la longueur de la découpe sont affichées.

W:***mm
L:***mm

9. Appuyez sur [▲][▼] pour déplacer le matériau et positionner le repère de découpe ( ) au-dessus du
protecteur de lame ( ).

Les repères de découpe ne peuvent pas être lus dans les situations indiquées ci-dessous. Retirez le matériau
une fois, puis rechargez-le.

• Les repères de découpe sont séparés du protecteur de lame ( ) par une distance de 15 mm ou plus ( )
• Les repères de découpe gauche et droit sont inclinés de 5 degrés ou plus ( ) par rapport au sens de dépla-

cement du chariot de coupe
• Les repères de découpe gauche et droit s’écartent de 20 mm ou plus ( ) dans le sens d’alimentation du

matériau

IMPORTANT
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10. Appuyez sur [◀][▶] pour déplacer le chariot de coupe de façon à ce que la pointe de la lame vienne se
placer au milieu du repère de découpe inférieur gauche.
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Étape 4: Configurer le réglage pour effectuer un alignement automatique

Positionnez les repères de découpe automatiquement grâce au capteur intégré de la machine.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<TOOL MODE>

3. Appuyez sur [▶].

4. Appuyez sur [▲] ou [▼] pour sélectionner "SENSOR MODE".

CROPMARK
 SENSOR MODE

5. Appuyez sur [ENTER] pour sélectionner le paramètre.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.
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Étape 5: Envoyer des données d’impression et de coupe vers CutStudio

Procédure

1. Affichez la couche contenant les lignes de coupe sur CorelDRAW et sélectionnez-la.

2. Dans la palette [Roland CutStudio], sélectionnez [Output Current Layer], puis cliquez sur [Update].

Confirmez que la ligne de coupe à sortir est affichée sur l’écran de prévisualisation.

3. Cliquez sur .

CutStudio démarre, et les données de la ligne de coupe sont envoyées à CutStudio.
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Étape 6: Réglage des conditions de coupe

Procédure

1. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

2. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

3. Cliquez sur [Change] sous [Media Size].
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4. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et [Width] et [Length] dans [Cutting
Area] seront mis à jour.

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

5. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

6. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

7. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL
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Étape 7: Découpe

Envoyez les données d’impression et de coupe à la machine, et démarrez la découpe.

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Dans CutStudio, cliquez sur .

La fenêtre [Cut] s’affiche.

2. Cliquez sur [OK].

Les données d’impression et de coupe sont envoyées à la machine. Quand la machine reçoit les
données d’impression et de coupe, elle lit automatiquement les repères de découpe avec un cap-
teur, puis démarre la coupe.

Si le capteur ne parvient pas à lire les repères de découpe, l’écran ci-dessous apparaît.

Si l’écran suivant apparaît, reportez-vous à la section Les repères de découpe ne sont pas détectés(P.
296) pour résoudre l’erreur.

Si cela ne résout pas le problème, passez en mode Outil, puis effectuez l’alignement. 

P. 178Imprimer et Couper en mode Outil

RAPPEL
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SET TO
<TOOL MODE>

3. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau
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Procédures après la sortie
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Pause et annulation de l’impression............................................................... 176
Mise en pause de la sortie .................................................................... 176
Annulation de l’impression ................................................................... 176
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Après la sortie, déchargez ou coupez le matériau de la machine.

Retrait du matériau

Quand la découpe est terminée, retirez le matériau.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [ENTER].

Le chariot de coupe revient en position de départ.

3. Abaissez le levier de chargement.

N’utilisez pas une force excessive lorsque vous déplacez le levier de chargement.
Vous risqueriez de l’endommager.

IMPORTANT

4. Retirez le matériau.

Déchargement/Coupe du matériau
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Découpe du matériau

Après la sortie, coupez le matériau selon vos besoins.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

W:***mm
L:***mm

2. Appuyez sur [▲][▼] pour faire avancer le matériau jusqu’à ce que la ligne de coupe dépasse la position
du guide de la lame ( ).

3. Coupez le matériau avec une lame, etc., le long du guide de la lame situé sur la surface avant de la ma-
chine.

Déchargement/Coupe du matériau
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Mise en pause de la sortie

Un processus de découpe en cours peut être mis en pause, et la sortie de découpe en pause peut être re-
prise.

Cette opération peut compromettre la qualité de la coupe. Dans la mesure du possible, évitez les pauses.

RAPPEL

Procédure

1. Appuyez sur [PAUSE] avant la fin de l’impression.

La sortie de coupe s’interrompt.

2. Appuyez de nouveau sur [PAUSE].

L’impression reprend.

Annulation de l’impression

Effectuez l’opération suivante pour terminer la coupe alors que le processus est en cours.

Cette opération annule les données de sortie et ne permet pas de reprendre la coupe.

RAPPEL

Procédure

1. Appuyez sur [PAUSE] avant la fin de l’impression.

La sortie de coupe s’interrompt.

2. Maintenez la touche [ENTER] enfoncée pendant une seconde ou plus.

Les données de sortie sont annulées. Recommencez la coupe.
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Le mode Outil peut être utilisé dans les situations suivantes.

• Quand il n’est pas possible d’effectuer l’alignement en mode Capteur

• Quand vous effectuez Imprimer et Couper sans sélectionner le type de matériau

Il n’est pas possible d’utiliser le mode Outil lorsque vous utilisez seulement 3 repères de découpe.

RAPPEL

Articles requis

Outil d’alignement
Matériau sur lequel des repères d’outils ont été imprimés

( )

Étape 1: Définir la méthode d’alignement (mode Outil)

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<SENSOR MODE>

3. Appuyez sur [▶].

CROPMARK
 SENSOR MODE

4. Appuyez sur [▲] ou [▼] pour sélectionner "TOOL MODE".

CROPMARK
 TOOL MODE

5. Appuyez sur [ENTER].

CROPMARK
<TOOL MODE>

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.

Imprimer et Couper en mode Outil
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Étape 2: Découpe après alignement automatique

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Quand [File]>[Print&Cut] de CutStudio est désélectionné, sélectionnez ceci.

2. Envoyez les données de découpe.

L’écran ci-dessous apparaît.

REPLACE TO TOOL
(QUIT   MENU)

3. Retirez le porte-lame et installez l’outil d’alignement.

L’outil d’alignement peut être installé de la même manière que le porte-lame.

4. Appuyez sur [ENTER].

L’écran ci-dessous apparaît.

Imprimer et Couper en mode Outil
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MARK1 SET
(RETURN MENU)

5. Appuyez sur [▲][▼][◀][▶], et alignez la pointe de l’outil d’alignement sur le repère d’outils 1.

Maintenez l’outil d’alignement doucement depuis le dessus haut avec votre doigt et vérifiez que la
pointe de l’outil d’alignement chevauche le repère d’outils.

6. Appuyez sur [ENTER].

L’outil se déplace jusqu’à une position proche du repère de découpe inférieur droit, et l’écran ci-
dessous s’affiche.

MARK2 SET
(RETURN MENU)

7. Appuyez sur [▲][▼][◀][▶], et alignez la pointe de l’outil d’alignement sur le repère d’outils 2.

Pour effectuer à nouveau l’alignement, appuyez sur [MENU] pendant la configuration pour revenir à l’écran
précédent, puis effectuez à nouveau la procédure.

RAPPEL

8. Appuyez sur [ENTER].

L’outil se déplace jusqu’à une position proche du repère de découpe supérieur gauche, et l’écran
ci-dessous s’affiche.

MARK3 SET
(RETURN MENU)

9. Alignez les repères d’outils 3 et 4 de la même manière.

Repère d’outils 3 Repère d’outils 4
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10. Après avoir aligné le repère d’outils 4, appuyez sur [ENTER].

L’écran ci-dessous apparaît.

REPLACE TO BLADE
(RETURN MENU)

11. Retirez l’outil d’alignement et installez le porte-lame.

12. Appuyez sur [ENTER].

13. Appuyez sur [ENTER] lorsque l’écran suivant apparaît.

La découpe commence.

COMPLETE ENTER
QUIT    MENU

14. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 43 Installez le porte-lame

・  P. 173 Retrait du matériau

Imprimer et Couper en mode Outil
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En utilisant le mode manuel, vous pouvez Imprimer et Couper sans utiliser CutStudio, Adobe Illustrator ou
CorelDRAW.

Vérifiez au préalable le matériau compatible et l’imprimante à utiliser.

Imprimante à utiliser

Imprimante laser ou à jet d’encre d’une résolution de 720 dpi ou plus

 LIENS CONNEXES 

・  P. 15 Conditions des matériaux utilisables

Étape 1: Créer manuellement des données de repère d’outils

Créez des données de repère d’outils en utilisant un logiciel autre que CutStudio, Adobe Illustrator ou Co-
relDRAW.

Lorsque vous utilisez un logiciel d’application pour ajouter des repères d’outils à une illustration, définis-
sez la position en tenant compte de la marge nécessaire à la découpe.
Cette section décrit comment créer manuellement des données de repères d’outils en utilisant des don-
nées d’échantillon.

Données d’échantillon :

Sample.bmp trouvé dans le dossier d’installation de CutStudio (normalement situé dans le dossier [Pro-
gram Files (x86)]>[CutStudio] du lecteur C)

Procédure

1. Dessinez des repères d’outils.

Il n’y a pas de modèle particulier à utiliser pour les repères d’outils, mais utiliser des formes avec
des angles comme indiqué dans la figure ci-dessous facilite l’alignement.

Le point d’origine de la découpe se trouve en bas à gauche. Le repère d’outils de l’origine doit
être reconnaissable parmi d’autres repères d’outils.

2. Déterminez les marges.

Lorsque vous utilisez un matériau avec une grande quantité à alimenter (matériau long), il est re-
commandé de définir les marges suivantes : environ 25 mm ( ) à gauche et à droite respective-
ment, environ 20 mm ( ) en haut dans le sens d’alimentation du matériau, et environ 50 mm ( )
à l’arrière dans le sens d’alimentation.

Imprimer et Couper en mode manuel
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3. Notez la distance entre les repères d’outils (largeur : W, longueur : L).

4. Notez les valeurs de décalage.

Vérifiez l’origine (où X et Y sont tous deux égaux à 0) du logiciel, et notez la distance entre ce
point d’origine ( ) et le repère d’outils inférieur gauche (W, L).

5. Positionnez l’illustration dans la zone de coupe définie par les repères d’outils.

Imprimer et Couper en mode manuel
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 LIENS CONNEXES 

・  P. 342 Marges et distance entre les repères de découpe

Imprimer et Couper en mode manuel
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Étape 2: Générer les données d’impression et de coupe

1. Imprimer les données d’impression et de coupe

Procédure

1. Chargez le matériau dans l’imprimante.

Pour savoir comment charger le matériau dans l’imprimante, consultez la documentation de l’im-
primante.

Lorsque l’impression agrandie/réduite est activée, désactivez-la. Veillez à imprimer avec une échelle de 100
%.

IMPORTANT

2. Imprimez les données d’impression et de coupe.

Imprimer et Couper en mode manuel
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2. Chargement du matériau imprimé

Chargez dans la machine le matériau imprimé à partir d’une imprimante.

Le matériau se gondole parfois quand il est imprimé par l’imprimante. Aplatissez le matériau gondolé avant de le char-
ger dans la machine.

IMPORTANT

Procédure

1. Vérifiez l’origine ( ) pour la découpe du matériau.

2. Configurez l’origine de la découpe sur le coin inférieur gauche du matériau, puis chargez le matériau
dans la machine.

Si le matériau est chargé dans le mauvais sens, les valeurs notées dans les procédures 3 et 4 de l’étape 1 de-
viennent invalides, et la découpe ne pourra pas être effectuée correctement.

IMPORTANT

3. Positionnez les rouleaux-pinceurs.

Tenez compte des points suivants lors du positionnement des rouleaux-pinceurs.

• Positionnez les rouleaux-pinceurs ( ) à l’extérieur des repères d’outils ( ).

• Assurez-vous qu’un rouleau-pinceur ( ) est réglé dans la plage de la partie abrasive ( ).
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4. Alignez le bord gauche du matériau de manière à ce qu’il soit à peu près parallèle à la ligne guide ( ).

Vue du dessus de la machine

5. Relevez le levier de chargement pour installer le matériau à sa place.

6. Mettez la machine en marche.

7. Sélectionnez [FEUILLE] comme type de matériau.

8. Appuyez sur [ENTER].

La largeur et la longueur de la découpe sont affichées.

W:***mm
L:***mm
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9. Appuyez sur [▲][▼] pour déplacer le matériau et positionner le repère d’outils ( ) au-dessus du protec-
teur de lame ( ).

Si l’une des situations suivantes se produit, retirez le matériau une fois, puis rechargez-le.

• Les repères d’outils sont éloignés du protecteur de lame de 15 mm ou plus
• Les repères d’outils gauche et droit sont inclinés de 5 degrés ou plus par rapport au sens de déplacement

du chariot de coupe
• Il dévie de 20 mm ou plus dans le sens d’alimentation du matériau

IMPORTANT

10. Appuyez sur [◀][▶] pour déplacer le chariot de coupe de façon à ce que la pointe de la lame vienne se
placer sur le repère d’outils inférieur gauche.
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Étape 3: Configuration de la méthode d’alignement (mode manuel)

1. Sélectionner le mode manuel

Réglez la méthode d’alignement des repères de découpe sur le mode manuel.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CROPMARK
<SENSOR MODE>

3. Appuyez sur [▶].

CROPMARK
 SENSOR MODE

4. Appuyez sur [▲][▼], et sélectionnez "MANUEL".

CROPMARK
 MANUAL

5. Appuyez sur [ENTER].

CROPMARK
<MANUAL>

6. Appuyez sur [▶].
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2. Saisissez la distance entre les repères d’outils

Saisissez la distance, largeur (W, width) et longueur (L, length), qui a été notée lors de la création manuel-
le des repères d’outils.

Procédure

1. Appuyez trois fois sur [▶] pour afficher l’écran ci-dessous.

WIDTH 160
*160mm

2. Appuyez sur [▲][▼] et saisissez la distance horizontale ("LARGEUR") entre les repères d’outils.

WIDTH 160
*180mm

3. Appuyez sur [ENTER] pour sélectionner le paramètre.

WIDTH 180

4. Appuyez sur [▼], puis [▶] pour afficher l’écran illustré ci-dessous.

LENGTH 210
*210mm

5. Appuyez sur [▲][▼] et saisissez la distance verticale ("LONGUEUR") entre les repères d’outils.

LENGTH 210
*230mm

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

LENGTH 230
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 LIENS CONNEXES 

・  P. 182 Créer manuellement des données de repère d’outils
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3. Saisir les valeurs de décalage

Saisissez la distance de décalage, largeur (W, width) et longueur (L, length), qui a été notée lors de la
création manuelle des repères d’outils.

Procédure

1. Appuyez sur [▼], puis [▶] pour afficher l’écran illustré ci-dessous.

OFFSET W 0.5
*0.5mm

2. Saisissez la valeur du décalage en largeur (W) avec [▲][▼].

OFFSET W 0.5
*0.0mm

3. Appuyez sur [ENTER] pour sélectionner le paramètre.

OFFSET W 0.0

4. Appuyez sur [▼], puis [▶] pour afficher l’écran illustré ci-dessous.

OFFSET L 0.5
*0.5mm

5. Saisissez la valeur du décalage en longueur (L) avec [▲][▼].

OFFSET L 0.5
*0.0mm

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

OFFSET L 0.0
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 LIENS CONNEXES 

・  P. 182 Créer manuellement des données de repère d’outils
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Étape 4: Découpe (mode manuel)

Ne jamais toucher le chariot de coupe pendant que l’impression est en cours.
Le chariot de coupe se déplace à grande vitesse. Le contact avec le chariot en mouvement peut entraîner des blessu-
res.

AVERTISSEMENT

Procédure

1. Appuyez sur [◀], puis [▼] pour afficher l’écran illustré ci-dessous.

Pour 3 repères d’outils, sélectionnez "START 3 POINTS".

MANUAL
4-POINT START

2. Appuyez sur [ENTER].

L’écran ci-dessous apparaît.

REPLACE TO TOOL
(QUIT   MENU)

3. Retirez le porte-lame et installez l’outil d’alignement.

L’outil d’alignement peut être installé de la même manière que le porte-lame.

4. Appuyez sur [ENTER].

L’écran ci-dessous apparaît.

MARK1 SET
(RETURN MENU)

5. Appuyez sur [▲][▼][◀][▶], et alignez la pointe de l’outil d’alignement sur le repère d’outils 1.

Maintenez l’outil d’alignement doucement depuis le dessus haut avec votre doigt et vérifiez que la
pointe de l’outil d’alignement chevauche le repère d’outils.
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6. Appuyez sur [ENTER].

L’outil se déplace vers une position proche du repère d’outils en bas à droite, puis l’écran ci-des-
sous apparaît.

MARK2 SET
(RETURN MENU)

7. Appuyez sur [▲][▼][◀][▶], et alignez la pointe de l’outil d’alignement sur le repère d’outils 2.

Pour effectuer à nouveau l’alignement, appuyez sur [MENU] pendant la configuration pour revenir à l’écran
précédent, puis effectuez à nouveau la procédure.

RAPPEL

8. Appuyez sur [ENTER].

L’outil se déplace vers une position proche du repère d’outils inférieur droit, puis l’écran ci-des-
sous apparaît.

MARK3 SET
(RETURN MENU)

9. Alignez les repères d’outils 3 et 4 de la même manière.
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10. Après avoir aligné le repère d’outils 4, appuyez sur [ENTER].

L’écran ci-dessous apparaît.

REPLACE TO BLADE
(RETURN MENU)

11. Retirez l’outil d’alignement et installez le porte-lame.

12. Appuyez sur [ENTER].

13. Appuyez sur [ENTER] lorsque l’écran suivant apparaît.

COMPLETE ENTER
QUIT    MENU

14. Lorsque l’écran ci-dessous s’affiche, envoyez les données de coupe depuis l’ordinateur.

OUTPUT DATA

Lorsque la machine reçoit les données, elle commence la découpe.

15. Retirez le matériau coupé.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau

・  P. 43 Installez le porte-lame
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Guide général concernant les conditions de coupe

Les trois conditions de coupe sont la force de la lame, la vitesse de coupe et le décalage de la pointe de la
lame.

Un guide général des conditions de coupe et de la durée de vie de la lame pour différentes combinaisons
de matériaux et de lames est donné ci-dessous.

Notez qu’un découpage optimal n’est pas forcément obtenu simplement en se conformant aux conditions
ci-dessous. Avant de couper, assurez-vous d’effectuer un test de découpe avec une lame adaptée au maté-
riau.

Certaines lames sont adaptées à certains matériaux. La coupe de matériaux qui ne sont pas spécifiés comme adaptés
peut entraîner la rupture de la lame.

IMPORTANT

Lame Matériel Force de la lame
(gf)

Vitesse de cou-
pe (cm/sec)*1

Décalage de la
pointe de la la-

me (mm)

Durée de vie
(m) *2

ZEC-U5032 Vinyle de signalisation générale 30 à 100 20 ou moins 0,25 4,000

ZEC-U5025
Vinyle de signalisation générale 40 à 100 20 ou moins

0,25
4,000

Vinyle fluorescent 120 à 200 10 ou moins 2,500

 

*1 Plus la vitesse de découpe est rapide, plus la qualité de l’image est mauvaise. Réglez la vitesse en fonction de la qualité
d’image requise.

*2 La durée de vie est un indicateur général dans le cas où le même type de matériaux a été coupé.
 

Si les zones non coupées restent égales même lorsque la force de la lame est augmentée à une valeur supérieure de 50
à 60 gf aux valeurs indiquées dans ce tableau, remplacez la lame.

RAPPEL

 LIENS CONNEXES 

・  P. 45 Réaliser un test de découpe

・  P. 201 Réglage du paramètre de coupe

・  P. 286 Remplacement de la lame
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Effectuez un test de découpe avant de régler le paramètre de coupe. Ajustez les conditions de coupe
après avoir vérifié le résultat du test de découpe. Vous pouvez modifier la force de la lame, la vitesse de
coupe et le décalage de la pointe de la lame à partir de la fenêtre [Print Setting] du pilote d’imprimante
(ou de CutStudio/VersaWorks).

 LIENS CONNEXES 

・  P. 45 Réaliser un test de découpe

Ajustement de la profondeur de coupe

Si vous souhaitez effectuer un réglage précis et fin de la profondeur de coupe, par exemple lorsque vous
découpez du matériau avec une base papier fine, vous pouvez obtenir de bons résultats en ajustant la
quantité d’extension de la lame. Tournez le capuchon du porte-lame pour régler la longueur de l’extension
de la lame.

L’extension de la lame ( ) est de 0 mm ( ) au minimum et de 2,5 mm ( ) au maximum. Un ajustement
de 0,5 mm peut être effectué en tournant le capuchon d’un tour complet.

Réglez la valeur de l’extension de la lame ( ) à une valeur égale à la somme de l’épaisseur de la partie
du matériau ( ) et de la moitié ( ) de l’épaisseur de la base papier ( ).

Si vous découpez des lignes perforées dans un matériau sans base papier, réglez la valeur de l’extension de la lame ( )
de manière à ce que la lame s’étende légèrement quand elle perce le matériau ( ). Si vous poussez la lame trop loin,
vous risquez d’endommager la lame et le protecteur de lame et d’accélérer leur détérioration.

RAPPEL
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Configuration de la force de la lame

Si le modèle se décolle ou si la base papier est aussi coupée avec le matériau, modifiez la force de la la-
me.

Procédure

1. Vérifiez que le curseur PEN FORCE [PEN FORCE] est en position centrale (au « 0 » sur l’échelle).

▲
▲ ▲▲

-2 -1 0 +1 +2

2. Appuyez sur [FORCE].

La force actuelle de la lame est affichée.

FORCE 50gf
* 50gf

3. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

4. Appuyez sur [ENTER] pour sélectionner le paramètre.

• Réglage d’usine par défaut : 50 gf
• Plage de réglages : 30 à 500 gf (modifiable par incréments de 10 gf)

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

Affinage de la force de la lame

Après avoir réglé la force de la lame avec le menu "PRESSION", vous pouvez affiner le réglage de la force
de la lame avec le curseur PEN FORCE. "PRESSION"Utilisez cette opération lorsque vous souhaitez que la
force de la lame soit légèrement supérieure ou inférieure au réglage effectué avec le menu.

Procédure

1. Ajustez la force de la lame avec le curseur PEN FORCE.

Réglage du paramètre de coupe
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▲
▲ ▲▲

-2 -1 0 +1 +2

• Plage de réglage : ±30 gf environ

La valeur ajustée ici n’est donnée qu’à titre indicatif. La précision de cette valeur n’est pas garantie.

RAPPEL
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Configuration de la vitesse de coupe

Réglez la vitesse de coupe.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez sur [▶].

3. Appuyez sur [▲][▼] pour afficher l’écran suivant.

SPEED 40cm/s

4. Appuyez sur [▶].

5. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

SPEED 40cm/s
  10cm/s

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : 20 cm/s
• Plage de réglages : 1 à 85 cm/s (incréments de 1 cm/s)

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe
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Réglage du décalage de la pointe de la lame

Ce paramètre vous permet de régler le décalage (offset) de la pointe de la lame. Entrez la valeur d’offset
indiquée pour la lame. Quand vous utilisez la lame fournie, la découpe peut être réalisée en utilisant les
réglages par défaut.

Si le début d’une coupe dévie de l’emplacement prévu ou si les coins d’une forme ne sont pas nets, ajustez la valeur du
décalage.

RAPPEL

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez sur [▶].

3. Appuyez sur [▲][▼] pour afficher l’écran suivant.

OFFSET 0.250mm

4. Appuyez sur [▶].

5. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

OFFSET 0.250mm
  0.500mm

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : 0,250 mm
• Plage de réglages : 0,000 à 1,000 mm (par incréments de 0,025 mm)

RAPPEL
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Définir l’orientation des coordonnées de coupe

Faites pivoter les coordonnées de coupe, et décidez de la direction dans laquelle couper le matériau.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez sur [▶].

3. Appuyez sur [▲][▼] pour afficher l’écran suivant.

ROTATE 0deg A

4. Appuyez sur [▶].

5. Appuyez sur [▲] ou [▼] pour sélectionner un réglage.

ROTATE 0deg A
*0deg A

"0deg" Les flèches dans les figures suivantes indiquent les direc-
tions positives des axes X et Y respectivement.

• Point d’origine : En bas à gauche
• Axe de coordonnées :

Direction verticale : Axe Y
Direction horizontale : Axe X

Réglage du paramètre de coupe
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"90deg" Les flèches dans les figures suivantes indiquent les direc-
tions positives des axes X et Y respectivement.

• Point d’origine : En bas à droite
• Axe de coordonnées :

Direction verticale : Axe X
Direction horizontale : Axe Y

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

• Réglage d’usine par défaut : "0deg"

RAPPEL

Vous pouvez également confirmer la valeur du réglage en appuyant plusieurs fois sur MENU pour
afficher l’écran suivant.

• Quand il est réglé sur "0deg"

20cm/s
250gf 0.250mm ∠A

• Quand il est réglé sur "90deg"

20cm/s
250gf 0.250mm ∠ A

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe
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Extension de la zone de coupe

L’extension de la zone de coupe permet une utilisation maximale du matériau.

Selon le dessin à découper, les rouleaux-pinceurs peuvent passer au-dessus de la ligne de coupe.

RAPPEL

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez sur [▶].

3. Appuyez sur [▲][▼] pour afficher l’écran suivant.

EXTEND 0.0mm

4. Appuyez sur [▶].

5. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

EXTEND 0.0mm
  10.0mm

• La valeur définie est appliquée aux deux extrémités de la zone de coupe.
• Si "EXTENSION" est configuré après le chargement du matériau, la valeur "W" affichée sur le panneau de

commande sera différente de la largeur de coupe réelle.

IMPORTANT

Réglage du paramètre de coupe
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Exemple : Lors du réglage de 0 mm à 10,0 mm

200 mm

220 mm

10 mm

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : 0,0 mm
• Plage de réglages : 0,0 à 10,0 mm

RAPPEL

 LIENS CONNEXES 

・  P. 39 Sélectionner le type de matériau
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Réglage de la vitesse de la lame pendant la coupe

Ce paramètre vous permet de définir la vitesse de déplacement de la lame vers la position de coupe sui-
vante. La lame est soulevée du matériau pendant l’opération de coupe. Quand vous découpez un matériau
plus fin ou plus épais que le matériau standard, il peut-être mieux de diminuer la vitesse pour éviter des
problèmes comme le soulèvement du matériau.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, suivez la procédure suivante pour afficher l’écran.
1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez sur [▼].

RAPPEL

2. Appuyez sur [▶].

3. Appuyez sur [▲][▼] pour afficher l’écran suivant.

UPSPEED 40cm/

4. Appuyez sur [▶].

5. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

UPSPEED 40cm/
  AUTO

Quand "AUTO" est activé, il se déplace à la vitesse définie dans "VITESSE". L’augmentation de "VIT
MAX" raccourcit le temps de coupe.

6. Appuyez sur [ENTER] pour sélectionner le paramètre.

7. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "AUTO"
• Plage de réglages : 10 à 85 cm/s (incréments de 5 cm/s), "AUTO"

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe
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Découpage en douceur des arcs et autres courbes (Lissage)

Vous pouvez régler les courbes des données de découpe envoyées à cette machine pour qu’elles soient lis-
sées. Positionnez normalement le levier de réglage de la hauteur sur "OUI". Si les coins sont trop ronds lors
de la découpe de petits textes ou de formes complexes, configurez ce paramètre sur "NON". Nous vous re-
commandons de le régler également sur "NON" quand vous devez augmenter la productivité sans tenir
compte de la qualité.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

SMOOTHING ON

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner "OUI" ou "NON".

SMOOTHING ON
*ON

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "OUI"

RAPPEL
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Couper à la même position de façon répétitive (Superposition)

La coupe est répétée plusieurs fois à la même position avec les mêmes données de coupe. Utilisez ce para-
mètre pour les matériaux qui ne peuvent pas être coupés en un seul passage, comme les matériaux épais.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

OVERLAP OFF

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

OVERLAP OFF
*OFF

En plus de la coupe normale, la coupe est effectuée un nombre de fois égal à la valeur définie.

RAPPEL

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "NON"
• Plage de réglage : "NON", 1 à 10

RAPPEL

Réglage du paramètre de coupe
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 LIENS CONNEXES 

・  P. 82 Découpe

Réglage du paramètre de coupe
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Couper les coins proprement (Surcoupe)

Cette fonction coupe ce qui est en trop au début et à la fin d’une ligne de coupe. Elle est efficace quand
vous souhaitez obtenir des angles particulièrement nets, par exemple lors de la découpe de matériaux plus
épais. Lors de la découpe de petits caractères ou de formes complexes, cette fonction est normalement
réglée sur "NON" pour éviter de couper les parties nécessaires du matériau.

"OUI" "NON"

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

OVER CUT OFF

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner "OUI" ou "NON".

Réglage du paramètre de coupe
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OVER CUT OFF
*OFF

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "NON"

RAPPEL

Réglage du paramètre de coupe
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Utilisation d’un matériau plus fin ou plus dur que la normale

Mettez en marche le ventilateur aspirant pour maintenir le matériau en place pendant la coupe pour évi-
ter que le matériau ne se soulève ou ne se déplace. Normalement, utilisez "AUTO" tel quel. Cependant, le
volume d’air du ventilateur aspirant doit être réduit lors de l’utilisation de matériaux fins et/ou peu fer-
mes.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

VACUUMFAN AUTO

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

Utilisez un volume d’air plus faible lorsque vous utilisez un matériau fin.

VACUUMFAN AUTO
*AUTO

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "AUTO"

RAPPEL

Prévention et correction des désalignements de
coupe
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• Plage de réglages : 1 à 5, "AUTO"

Prévention et correction des désalignements de coupe
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Prévention des coupes mal alignées

Le matériau est alimenté automatiquement avant et pendant la coupe pour éviter tout problème d’aligne-
ment des positions de coupe. Si ce paramètre est réglé sur "OUI", le matériau est automatiquement avancé
de 1 m à chaque fois que l’ordinateur envoie des données de coupe (selon les données, le matériau peut
être avancé de 1 m ou plus), puis la coupe commence.

Si le matériau a déjà été retiré avec "AIRE", le matériau ne sera pas retiré automatiquement pour la quantité qui a déjà
été retirée, même si "PRE-DEFIL" est réglé sur "OUI".

RAPPEL

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

PRE-FEED OFF

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner "OUI" ou "NON".

PRE-FEED OFF
*OFF

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Quand "OUI" est sélectionné, réglez la vitesse d’alimentation du matériau.

(1) Appuyez deux fois sur [▶] pour afficher l’écran illustré ci-dessous.

Prévention et correction des désalignements de coupe
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SPEED 40cm/s

(2) Appuyez sur [▶].

(3) Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

(4) Appuyez sur [ENTER] pour sélectionner le paramètre.

9. Appuyez sur [MENU] pour revenir à l’écran d’origine.

• Réglage d’usine par défaut : "NON"
• Plage de réglages : "OUI" (1 à 10 cm/s), "NON"

RAPPEL

Prévention et correction des désalignements de coupe
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Ajustement de la position de coupe

Si la position d’impression et la position de découpe sont décalées comme le montre la figure suivante,
vous pouvez corriger le problème en les ajustant. Cet exemple montre la procédure d’ajustement de la
position de coupe.

 : Ligne de coupe prévue

 : Ligne de coupe réelle

Procédure

1. Vérifiez que le matériau a été chargé.

2. Vérifiez les valeurs de correction en fonction de l’état de la coupe.

"CROP-L" indique le sens d’alimentation du matériau, et "CROP-W" indique le sens de déplacement
du chariot de coupe.

Exemple : Pour déplacer la ligne de coupe de 0,5 mm vers la droite ( ) et de 0,7 mm vers le haut ( )

+

+
-

-

• CROP-W : Réglé sur +0,500

• CROP-L : Réglé sur +0,700

3. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

4. Appuyez sur [▼] pour afficher l’écran suivant.

Prévention et correction des désalignements de coupe
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OTHERS

5. Appuyez sur [▶].

6. Appuyez sur [▲][▼] pour afficher l’écran suivant.

CROP ADJ.

7. Définissez les valeurs de correction pour CROP-L et CROP-W.

(1) Appuyez deux fois sur [▶] pour afficher l’écran illustré ci-dessous.

CROP-L 0.000
*0.000mm

(2) Appuyez sur [▲][▼] pour définir la valeur de correction pour CROP-L.

(3) Appuyez sur [ENTER] pour sélectionner le paramètre.

(4) Appuyez sur "▼", puis "▶" pour afficher l’écran illustré ci-dessous.

CROP-W 0.000
*0.000mm

(5) Appuyez sur [▲][▼] pour définir la valeur de correction pour CROP-W.

(6) Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.

9. Effectuez à nouveau la découpe.

Si le problème d’alignement de la ligne de coupe est corrigé, le réglage est terminé. Si un ajuste-
ment supplémentaire est nécessaire, répétez le processus.

RAPPEL
• Réglage d’usine par défaut :

"CROP-L" : (Sens d’alimentation du matériau) 0,000

"CROP-W" : (Sens de déplacement du chariot de coupe) 0,000

• Plage de réglage : -25,000 mm à +25,000 mm

Prévention et correction des désalignements de coupe
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Ajustement de la position d’impression

Si la position d’impression et la position de découpe sont décalées comme le montre la figure suivante,
vous pouvez corriger le problème en les ajustant. Cet exemple montre la procédure d’ajustement de la
position d’impression.

 : Ligne de coupe prévue

 : Ligne de coupe réelle

Procédure

1. Dans CutStudio, cliquez sur [File]>[Printing Setup].

Prévention et correction des désalignements de coupe
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2. Sélectionnez [Fine adjustment], puis cliquez sur [Adjust].

La fenêtre [Crop Mark Adjustment] s’affiche.

3. Aligner la position par rapport à une ligne ou un point ( ) proche de l’origine ( ).

Ajustez les valeurs [BaseX] et [BaseY] pour éliminer le désalignement, puis cliquez sur [OK].

• Quand la position de découpe dévie à gauche ou à droite de la position d’impression

Modifiez la valeur [BaseX]. Si la position de découpe est décalée à droite de la position d’im-
pression, augmentez la valeur ; si elle est décalée à gauche de la position d’impression, dimi-
nuez-la. Dans le cas présenté dans la figure ci-dessus, augmentez [BaseX].

• Quand la position de découpe dévie au-dessus ou en dessous de la position d’impression

Modifiez la valeur [BaseY]. Si la position de coupe est décalée au-dessus de la position d’im-
pression, augmentez la valeur ; si elle est décalée en dessous, diminuez-la. Dans le cas présen-
té dans la figure ci-dessus, augmentez [BaseY].

Si les positions d’impression et de coupe ne sont pas alignées à un endroit éloigné de l’origine
( ), comme le montre la figure suivante, même après avoir réglé les positions avec [BaseX] et
[BaseY], il se peut qu’un matériau dilaté, contracté ou déformé cause un écart entre les repè-
res de découpe imprimés et le réglage ([W], [L]). Passez à l’étape 4.

4. Placez [W] et [L] sur la fenêtre [Crop Mark Adjustment], et corrigez les différences.

Cependant, ces valeurs ne sont que des lignes directrices. Les valeurs optimales doivent être défi-
nies en changeant les valeurs et en coupant réellement le matériau plusieurs fois.

Prévention et correction des désalignements de coupe
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Avant de procéder au réglage, vérifiez que [BaseX] et [BaseY] ont été ajustés par rapport à une ligne ou un
point proche de l’origine ( ). Si l’alignement se fait par rapport à un point éloigné, le résultat du réglage de
l’étape 3 sera différent quand [W] et [L] sont réglés.

IMPORTANT

• Les lignes de coupe dévient vers l’extérieur de la position d’impression

C’est peut-être dû au fait que la distance entre les repères de découpe imprimés est plus lon-
gue que le réglage. Dans ce cas, configurez [W] et [L] sur des valeurs supérieures aux réglages
pour ajuster le positionnement.

• Les lignes de coupe dévient vers l’intérieur de la position d’impression

C’est peut-être dû au fait que la distance entre les repères de découpe imprimés est plus cour-
te que le réglage. Dans ce cas, configurez [W] et [L] sur des valeurs inférieures aux réglages
pour ajuster le positionnement.

 : Point d’origine

Les valeurs saisies dans la fenêtre [Crop Mark Adjustment] ne sont effectives que lorsque [Adjust] est
sélectionné dans la boîte de dialogue [Printing Setup]. Toutes les valeurs saisies sont effacées si [Fine
adjustment] est désélectionné ou si les paramètres [W] et [L] de [CROPMARK] sont modifiés.

IMPORTANT

Si le capteur ne parvient pas à lire les repères de découpe, l’écran ci-dessous apparaît.

Si l’écran suivant apparaît, reportez-vous à la section Les repères de découpe ne sont pas détectés(P.
296) pour résoudre l’erreur.

RAPPEL
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SET TO
<TOOL MODE>

Si cela ne résout pas le problème, passez en mode Outil, puis effectuez l’alignement. 

P. 178Imprimer et Couper en mode Outil

Prévention et correction des désalignements de coupe
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"RETRACER"

Les données reçues de l’ordinateur peuvent être enregistrées dans la mémoire de la machine, et ces don-
nées peuvent ensuite être utilisées à plusieurs reprises pour couper (recouper). Pour recouper, utilisez "RE-
TRACER" dans le menu d’affichage.

• Toutes les données reçues entre le moment où la machine est mise en condition de préparation et le
moment où la condition de préparation est annulée sont enregistrées.

• Les données ne sont pas effacées même lorsque la condition de préparation est annulée.

• Si la condition de préparation est annulée et que la machine est ensuite remise en condition de prépa-
ration, toutes les données qui ont été enregistrées sont écrasées par les nouvelles données envoyées
par l’ordinateur.

• Toutes les données sont effacées quand l’alimentation est coupée.

• Si les données stockées dans la mémoire de la machine dépassent 2 Mo, la recoupe ne peut pas être
effectuée tant que les données ne sont pas effacées. Si "RETRACER" est exécuté dans ces conditions,
"DONNEES SATUREES" apparaît. Si aucune donnée n’est enregistrée dans la mémoire de la machine,
"PAS DE DONNEES" apparaît lorsque "RETRACER" est sélectionné dans le menu.

Étape 1: Préparer les données pour la recoupe

Effacez toutes les données restant dans la mémoire de la machine, puis envoyez de nouvelles données
pour que seules les données requises soient stockées dans la mémoire de la machine.

Procédure

1. Vérifiez que le matériau a été chargé.

2. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

3. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

REPLOT
<DATA EXISTS>

Si "PAS DE DONNEES" est affiché, passez à l’étape 6.

4. Appuyez sur [▶].

REPLOT
*START

5. Appuyez sur [▼] pour sélectionner "EFFACER".

REPLOT
*CLEAR

6. Appuyez sur [ENTER].

Couper les mêmes données à répétition
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Les données sont effacées.

REPLOT
<NO DATA>

7. Envoyer des données depuis l’ordinateur.

Couper les mêmes données à répétition
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Étape 2: Recoupe

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

REPLOT
<DATA EXISTS>

3. Appuyez sur [▶].

REPLOT
*START

4. Appuyez sur [ENTER].

L’affichage revient à l’image ci-dessous et la coupe, qui a été enregistrée dans la mémoire, est ef-
fectuée.

20cm/s
250gf 0.250mm ∠A

Couper les mêmes données à répétition
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Enregistrement des conditions de coupe

Pour économiser le temps passé à définir les conditions de coupe à chaque changement de matériau, vous
pouvez enregistrer les conditions de coupe des matériaux fréquemment utilisés dans la mémoire. La pro-
chaine fois que vous utiliserez le même matériau, vous pourrez modifier les réglages en fonction de ce ma-
tériau en chargeant simplement la mémoire que vous avez enregistrée.

Huit ensembles de réglages peuvent être enregistrés dans les mémoires USER 1 à USER 8. L’écrasement
d’une mémoire supprime toutes les anciennes conditions de coupe qu’elle contient.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

MEMORY
<USER1>

3. Appuyez sur [▶], [▼], puis sur [▶].

SAVE USER1
50-20-0.250

L’écran affiche les valeurs des menus "PRESSION", "VITESSE", et "LAME" en partant de la gauche.

4. Appuyez sur [▲][▼] pour sélectionner le numéro de mémoire dans lequel vous souhaitez enregistrer les
conditions de coupe.

5. Appuyez sur [ENTER].

L’écran ci-dessous apparaît.

SAVE USER2

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.

Enregistrement des conditions de coupe fré-
quemment utilisées
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Bien que cela ne soit pas affiché à l’écran, UPSPEED (la vitesse à laquelle la lame se déplace quand elle ne
coupe pas) et la qualité de la coupe sont également enregistrées.

RAPPEL

Enregistrement des conditions de coupe fréquemment utilisées
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Chargement des conditions de coupe

Sélectionnez une mémoire enregistrée et appliquez-la au panneau de commande.

Vous pouvez sélectionner une mémoire de USER 1 à USER 8. Notez que le chargement des conditions de
coupe depuis la mémoire efface toutes les conditions de coupe qui n’ont pas été enregistrées.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

MEMORY
<USER1>

3. Appuyez deux fois sur [▶].

LOAD *USER1
50-20-0.250

4. Appuyez sur [▲][▼] pour sélectionner le numéro de mémoire que vous souhaitez charger.

5. Appuyez sur [ENTER] pour exécuter.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.

Enregistrement des conditions de coupe fréquemment utilisées
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La coupe perforée peut être utilisée pour découper des matériaux sans base papier ou pour faire des plis
sur les données de coupe.

La zone de coupe est séparée après la coupe pour éviter que le matériau ne se coince.

 LIENS CONNEXES 

・  P. 27 Mise en place du matériau

・  P. 41 Préparatifs en vue de la coupe

・  P. 57 Réglage des conditions de coupe

・  P. 67 Définir les conditions d’impression

Création de données de coupe perforées avec CutStudio

1. Créer des données de coupe perforées

Chargez le matériau dans la machine au préalable, et finissez de préparer la sortie de coupe.
P. 27Mise en place du matériau
P. 41Préparatifs en vue de la coupe

Procédure

1. Lancez CutStudio.

• Windows 11

a. Cliquez sur [Start].

b. Cliquez sur [Toutes les applications]>[Roland CutStudio]>[CutStudio].

• Windows 10

Dans le menu [Start], cliquez sur [Roland CutStudio]>[CutStudio].

• Windows 8.1

En bas à gauche de l’écran [Start], cliquez sur  pour afficher l’écran [Apps]. Cliquez sur
.

CutStudio démarre.

2. Créez une forme.

Séparation ultérieure de la zone de coupe
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Dans cet exemple, vous allez créer le dessin illustré dans la figure ci-dessous.

3. Cliquez sur .

La coupe perforée est activée, et l’objet est affiché en rouge.

Cliquez sur [File]>[Preference] pour afficher la fenêtre [Preference]. Cette fonction vous permet de définir
la couleur et l’affichage des lignes perforées.

RAPPEL

Pour annuler le réglage des lignes perforées, utilisez  pour sélectionner la forme pour laquelle vous souhai-

tez annuler la coupe perforée, puis cliquez sur . Une fois le réglage des lignes perforées annulé, la couleur
de la ligne de coupe redevient noire.

RAPPEL

Séparation ultérieure de la zone de coupe
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2. Définir les conditions de coupe perforées

Procédure

1. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

2. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

3. Cliquez sur [Change] sous [Media Size].

Séparation ultérieure de la zone de coupe
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4. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et mettez à jour [Width] et [Length] sous
[Cutting Area].

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

5. Cliquez sur [OK].

Séparation ultérieure de la zone de coupe
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

6. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

7. Décochez la case [Use perforated cutting conditions of machine].

Cela permet de saisir des valeurs sur [Perforated Cutting].

Séparation ultérieure de la zone de coupe
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8. Configurez [Perforation length], [Perforation Force], [Half-cut length], et [Half-cut Force] sous [Perfora-
ted Cutting].

•  : Longueur de perforation

Longueur de la pièce découpée dans le matériau

•  : Demi-longueur de découpe

Longueur de la pièce non découpée dans le matériau avec une force de lame retenue

Réglez la force de perforation ou la force de demi-coupe en fonction du type de matériau.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longueur de perforation : 20 mm Longueur de perforation : 20 mm Longueur de perforation : 1 mm

Demi-longueur de découpe : 1 mm Demi-longueur de découpe : 20 mm Demi-longueur de découpe : 20 mm

9. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 203 Configuration de la force de la lame
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・  P. 261 Configuration des conditions de coupe perforées sur la machine
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3. Découpe de lignes perforées

Procédure

1. Vérifiez que le matériau a été chargé.

2. Cliquez sur .

La fenêtre [Cut] s’affiche.

3. Sélectionnez le type de lignes de coupe que vous souhaitez modifier.

[All] Sort les lignes de coupe et les lignes de coupe perforées

[Cutlines only] Sort les lignes de coupe uniquement

[Perforated Cut Lines only] Sort uniquement les lignes de coupe perforées

4. Cliquez sur [OK].

La découpe commence.

5. Vérifiez le résultat de la coupe.

Réglez les conditions de coupe selon les besoins.

 LIENS CONNEXES 

・  P. 237 Définir les conditions de coupe perforées

・  P. 201 Réglage du paramètre de coupe
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Création de données de coupe perforées avec Adobe Illustrator

1. Créer des données de coupe perforées

Chargez le matériau dans la machine au préalable, et finissez de préparer la sortie de coupe.
P. 27Mise en place du matériau
P. 41Préparatifs en vue de la coupe

Cette section présente un exemple de création de données de coupe perforées avec Adobe Illustrator
2020. La procédure d’opération est la même pour les autres versions.

Procédure

1. Créez un nouveau document et dessinez une nouvelle forme ou ouvrez un fichier existant.

Dans cet exemple, vous allez créer le dessin illustré dans la figure ci-dessous.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.
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3. Sélectionnez un objet auquel vous souhaitez appliquer une coupe perforée.

4. Cliquez sur .
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5. Sélectionnez [Output Perforated Cut Lines Only].

6. Sur la palette, cliquez sur [Update].

Vérifiez que la ligne de coupe que vous souhaitez modifier est affichée sur l’écran de prévisualisa-
tion.

7. Cliquez sur .

CutStudio démarre, et les données de coupe sont envoyées à CutStudio. Les données de coupe en
sortie sont toujours alignées par rapport à l’origine de CutStudio, quelle que soit la position dans
Adobe Illustrator (sauf les données de repères de découpe).
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2. Définir les conditions de coupe perforées

Procédure

1. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

2. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

3. Cliquez sur [Change] sous [Media Size].
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4. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et mettez à jour [Width] et [Length] sous
[Cutting Area].

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

5. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

6. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

7. Décochez la case [Use perforated cutting conditions of machine].

Cela permet de saisir des valeurs sur [Perforated Cutting].
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8. Configurez [Perforation length], [Perforation Force], [Half-cut length], et [Half-cut Force] sous [Perfora-
ted Cutting].

•  : Longueur de perforation

Longueur de la pièce découpée dans le matériau

•  : Demi-longueur de découpe

Longueur de la pièce non découpée dans le matériau avec une force de lame retenue

Réglez la force de perforation ou la force de demi-coupe en fonction du type de matériau.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longueur de perforation : 20 mm Longueur de perforation : 20 mm Longueur de perforation : 1 mm

Demi-longueur de découpe : 1 mm Demi-longueur de découpe : 20 mm Demi-longueur de découpe : 20 mm

9. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 203 Configuration de la force de la lame
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・  P. 261 Configuration des conditions de coupe perforées sur la machine
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3. Découpe de lignes perforées

Procédure

1. Vérifiez que le matériau a été chargé.

2. Cliquez sur .

La fenêtre [Cut] s’affiche.

3. Sélectionnez le type de lignes de coupe que vous souhaitez modifier.

[All] Sort les lignes de coupe et les lignes de coupe perforées

[Cutlines only] Sort les lignes de coupe uniquement

[Perforated Cut Lines only] Sort uniquement les lignes de coupe perforées

4. Cliquez sur [OK].

La découpe commence.

5. Vérifiez le résultat de la coupe.

Réglez les conditions de coupe selon les besoins.

 LIENS CONNEXES 

・  P. 237 Définir les conditions de coupe perforées

・  P. 201 Réglage du paramètre de coupe
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Création de données de coupe perforées avec CorelDRAW

1. Créer des données de coupe perforées

Chargez le matériau dans la machine au préalable, et finissez de préparer la sortie de coupe.
P. 27Mise en place du matériau
P. 41Préparatifs en vue de la coupe

Cette section explique comment créer des données de coupe pour la coupe perforée avec CorelDRAW
2020. La procédure d’opération est la même pour les autres versions.

Procédure

1. Créez un nouveau document et dessinez une nouvelle forme ou ouvrez un fichier existant.

Dans cet exemple, vous allez créer le dessin illustré dans la figure ci-dessous.

2. Dans la barre d’outils, cliquez sur .

La palette [Roland CutStudio] apparaît.
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3. Sélectionnez un objet auquel vous souhaitez appliquer une coupe perforée.

4. Cliquez sur .

5. Sélectionnez [Output Perforated Cut Lines Only].

6. Cliquez sur [Update].

Vérifiez que la ligne de coupe que vous souhaitez modifier est affichée sur l’écran de prévisualisa-
tion.

7. Cliquez sur .
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CutStudio démarre, et les données de coupe sont envoyées à CutStudio. Les données de coupe en
sortie sont toujours alignées par rapport à l’origine de CutStudio, quelle que soit la position dans
CorelDRAW (sauf les données de repères de découpe).
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2. Définir les conditions de coupe perforées

Procédure

1. Cliquez sur [File]>[Cutting Setup].

La fenêtre [Cutting Setup] s’affiche.

2. Dans [Name], sous [Printer], sélectionnez [Roland DG GS2-24].

Le nom du modèle est défini.

3. Cliquez sur [Change] sous [Media Size].
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4. Cliquez sur [Get from Machine].

Récupérez la zone de découpe de la machine connectée, et mettez à jour [Width] et [Length] sous
[Cutting Area].

Si [The machine is not responding.] s’affiche, vérifiez les paramètres de cette machine et de l’ordinateur.

P. 301La machine ne fonctionne pas

RAPPEL

5. Cliquez sur [OK].
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Le réglage est enregistré et la fenêtre [Cutting Setup] apparaît.

6. Définissez les conditions de coupe.

Normalement, la case [Use cutting conditions of machine] est cochée.

Pour modifier la condition de coupe, décochez [Use cutting conditions of machine] et saisissez les
valeurs.

7. Décochez la case [Use perforated cutting conditions of machine].

Cela permet de saisir des valeurs sur [Perforated Cutting].
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8. Configurez [Perforation length], [Perforation Force], [Half-cut length], et [Half-cut Force] sous [Perfora-
ted Cutting].

•  : Longueur de perforation

Longueur de la pièce découpée dans le matériau

•  : Demi-longueur de découpe

Longueur de la pièce non découpée dans le matériau avec une force de lame retenue

Réglez la force de perforation ou la force de demi-coupe en fonction du type de matériau.

[Perforation length] ＞ [Half-cut
length]

[Perforation length] ＝ [Half-cut
length]

[Perforation length] ＜ [Half-cut
length]

Longueur de perforation : 20 mm Longueur de perforation : 20 mm Longueur de perforation : 1 mm

Demi-longueur de découpe : 1 mm Demi-longueur de découpe : 20 mm Demi-longueur de découpe : 20 mm

9. Cliquez sur [OK].

La plage et les conditions de coupe sont enregistrées.

La zone affichée en blanc dans CutStudio est la plage de découpe. Les caractères et les formes situés en de-
hors de cette zone ne seront pas découpés.

RAPPEL

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 203 Configuration de la force de la lame
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・  P. 261 Configuration des conditions de coupe perforées sur la machine
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3. Découpe de lignes perforées

Procédure

1. Vérifiez que le matériau a été chargé.

2. Cliquez sur .

La fenêtre [Cut] s’affiche.

3. Sélectionnez le type de lignes de coupe que vous souhaitez modifier.

[All] Sort les lignes de coupe et les lignes de coupe perforées

[Cutlines only] Sort les lignes de coupe uniquement

[Perforated Cut Lines only] Sort uniquement les lignes de coupe perforées

4. Cliquez sur [OK].

La découpe commence.

5. Vérifiez le résultat de la coupe.

Réglez les conditions de coupe selon les besoins.

 LIENS CONNEXES 

・  P. 237 Définir les conditions de coupe perforées

・  P. 201 Réglage du paramètre de coupe
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Configuration des conditions de coupe perforées sur la machine

Configurez les conditions de coupe perforée sur le panneau de commande de la machine. Dans cet exem-
ple, "DEMI-LONGUEUR", "DEMI-FORCE", et "LONG. DE COUPE" seront configurés.

•  : "LONG. DE COUPE"

Longueur de la pièce découpée dans le matériau

•  : "DEMI-LONGUEUR"

Longueur de la pièce non découpée dans le matériau avec une force de lame retenue

Ajustez "DEMI-FORCE" en fonction du type de matériau.

"LONG. DE COUPE" ＞ "DEMI-LONGUEUR" "LONG. DE COUPE" ＝ "DEMI-LONGUEUR" "LONG. DE COUPE" ＜ "DEMI-LONGUEUR"

Longueur de découpe : 20 mm Longueur de découpe : 20 mm Longueur de découpe : 1 mm

Demi-longueur de découpe : 1 mm Demi-longueur de découpe : 20 mm Demi-longueur de découpe : 20 mm

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].
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4. Appuyez sur [▲][▼] pour afficher l’écran suivant.

PERFORATE OFF

5. Appuyez sur [▶].

6. Appuyez sur [▲] ou [▼] pour sélectionner "OUI".

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez deux fois sur [▶] pour afficher l’écran illustré ci-dessous.

Réglez la longueur de demi-coupe.

HALF LEN.  0.5

(1) Appuyez sur [▶].

(2) Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

HALF LEN.  0.5
* 0.5mm

(3) Appuyez sur [ENTER] pour sélectionner le paramètre.

9. Appuyez sur [▼] pour afficher l’écran suivant.

Réglez la force de demi-coupe.

HALF FORCE  5

(1) Appuyez sur [▶].

(2) Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

HALF FORCE  5
* 5gf

(3) Appuyez sur [ENTER] pour sélectionner le paramètre.

10. Appuyez sur [▼] pour afficher l’écran suivant.

Réglez la longueur de coupe.

CUT LEN. 15.5

(1) Appuyez sur [▶].

(2) Appuyez sur [▲] ou [▼] pour sélectionner une valeur.

CUT LEN. 15.5
  15.5mm

(3) Appuyez sur [ENTER] pour sélectionner le paramètre.

11. Appuyez sur [MENU] pour revenir à l’écran d’origine.

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe
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Aperçu de la sortie pannelisée

Lorsque les données sont plus grandes que la plage de découpe, elles sont divisées en plusieurs morceaux
de matériau à sortir.

La sortie pannelisée n’est pas disponible pour les données d’impression et de coupe.

IMPORTANT

Fonction de la marge intérieure

Pour éviter les lacunes lors de la connexion de différentes pièces de matériau, le bord de chaque pièce de
sortie pannelisée peut avoir une zone de coupe supplémentaire. La partie supplémentaire qui est coupée
est appelée la marge intérieure ( ). Vous pouvez définir la marge intérieure selon vos besoins.

• Sans marge intérieure : Écarts entre les bords lorsque les pièces sont connectées

• Avec marge intérieure : Pas d’écart entre les bords lorsque les pièces sont connectées

Division des données de coupe et sortie sur plu-
sieurs morceaux de matériau
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Étape 1: Décider du nombre de pièces à diviser (panneau) en

Lors de l’édition de données de coupe divisées (pannelisée), il est bien d’imaginer d’abord la taille finale.

Cette section explique le cas de la découpe de données de grande taille comme indiqué ci-dessous.

550 mm

1 000 mm

1 000 mm

Procédure

1. Déterminez la taille de sortie des données.

1 000 mm

1 000 mm

2. Vérifiez la taille du matériau et décidez du nombre de pièces à utiliser.

Dans cet exemple, nous produisons des données en les divisant en 2 (verticales) x 2 (horizontales).
Assurez-vous que la taille du matériau combiné est supérieure à la taille des données de sortie.

550 mm

550 mm
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Étape 2: Configurer les conditions de sortie pannelisée

Active ou désactive la sortie pannelisée et les marges intérieures.

Chargez le matériau dans la machine au préalable, et finissez de préparer la sortie de coupe.
P. 27Mise en place du matériau
P. 41Préparatifs en vue de la coupe

Procédure

1. Lancez CutStudio.

2. Cliquez sur [File]>[Tiling].

La fenêtre [Tiling] s’affiche.

3. Cliquez sur [Change Size].
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4. Cliquez sur [Get from Machine].

La plage de découpe est récupérée à partir de la machine connectée, et les valeurs sont automati-
quement saisies.

5. Une fois les valeurs saisies automatiquement, cliquez sur [OK].

La taille du segment est mise à jour.
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6. Cochez la case [Tiled Output], puis entrez le nombre de panneaux.

7. Définissez les marges intérieures.

Si l’on saisit [Inner Margin], [Overall Size] est automatiquement mis à jour. Assurez-vous que
[Overall Size] est plus grand que la taille de sortie.

8. Cliquez sur [OK].
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Le document est affiché. Les bords des segments sont affichés même si une marge intérieure n’a
pas été définie.

 LIENS CONNEXES 

・  P. 263 Aperçu de la sortie pannelisée

・  P. 264 Décider du nombre de pièces à diviser (panneau) en
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Étape 3: Création de données de découpe

Créez des données de coupe, et vérifiez l’ordre de sortie et les conditions de coupe dans la prévisualisa-
tion.

Procédure

1. Saisissez le texte et/ou les formes que vous souhaitez.

Dans cet exemple, vous allez saisir les données indiquées dans la figure ci-dessous.

2. Cliquez sur [File]>[Cutting Preview].
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En cliquant sur [Next Page], les prévisualisations sont affichées dans l’ordre de coupe.
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Ordre de coupe

3. Vérifiez les données de coupe, et fermez la prévisualisation.
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Étape 4: Découpe

Commencez à couper en panneaux.

Procédure

1. Vérifiez que le matériau a été chargé.

2. Cliquez sur .

La fenêtre [DivCut Page] s’affiche.

3. Cliquez sur [OK].

La fenêtre [Cut] s’affiche.

4. Cliquez sur [OK].
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La découpe commence.

Une fois la coupe terminée, un écran de message s’affiche.

Lorsque vous utilisez un matériau plat, chargez un nouveau matériau plat.

RAPPEL

5. Cliquez sur [OK].
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6. Répétez les étapes 4 et 5.

Affiche le nombre de panneaux défini.

7. Combinez le matériau de sortie.

Alignez les marges pour terminer la procédure.
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Gestion optimisée des opéra-
tions

Gestion des paramètres de base de la machine ................................................. 276
Changement de la langue d’affichage ...................................................... 276
Modification de l’unité de longueur à afficher ............................................ 276
Réglage de la luminosité de l’écran......................................................... 278
Restauration des paramètres par défaut ................................................... 279
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Changement de la langue d’affichage

Procédure

1. Lorsque la machine est sous tension, appuyez sur le bouton d’alimentation pendant 1 seconde ou plus
pour la mettre hors tension.

2. Maintenez la touche [MENU] enfoncée et appuyez sur le bouton d’alimentation.

L’écran ci-dessous apparaît.

LANG. ENGLISH
*ENGLISH

3. Appuyez sur [▼] pour sélectionner la langue à afficher sur l’écran.

LANG  ENGLISH
にほんこﾞ

4. Appuyez sur [ENTER] pour sélectionner le paramètre.

Modification de l’unité de longueur à afficher

Changez l’unité utilisée pour l’affichage.

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶], [▼], puis sur [▶].

Gestion des paramètres de base de la machine
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UNIT mm
*mm

4. Sélectionnez l’unité avec [▲][▼].

Il est possible de sélectionner les millimètres ou les pouces.

5. Appuyez sur [ENTER] pour sélectionner le paramètre.

6. Appuyez sur [MENU] pour revenir à l’écran d’origine.
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Réglage de la luminosité de l’écran

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

CONTRAST 5

5. Appuyez sur [▶].

6. Appuyez sur [▲][▼] pour sélectionner la luminosité de l’écran.

CONTRAST 5
*5

• Plage de réglages : 1 à 5

7. Appuyez sur [ENTER] pour sélectionner le paramètre.

8. Appuyez sur [MENU] pour revenir à l’écran d’origine.
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Restauration des paramètres par défaut

Cette procédure ramène tous les paramètres à leurs valeurs d’usine par défaut.

Cette opération rétablit tous les paramètres à leur valeur par défaut, en supprimant toutes les modifications apportées
jusqu’alors. Conservez un registre de toutes les informations nécessaires, notamment les conditions de coupe.
Toutefois, le paramètre de la langue reste inchangé.

RAPPEL

Procédure

1. Appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

CONDITION

Lorsque le matériau est chargé, appuyez plusieurs fois sur [MENU] pour afficher l’écran suivant.

UNSETUP

RAPPEL

2. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

OTHERS

3. Appuyez sur [▶].

4. Appuyez plusieurs fois sur [▼] pour afficher l’écran suivant.

FACTORYDEFAULT
*PRESET

5. Appuyez sur [▶] pour afficher l’écran suivant.

FACTORYDEFAULT
*PRESET

6. Appuyez sur [ENTER] pour exécuter.

L’écran ci-dessous apparaît à nouveau.

SELECT SHEET
ROLL

Gestion des paramètres de base de la machine
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Le nettoyage est important pour garantir une coupe propre. Nettoyez régulièrement la machine.

Assurez-vous d’effectuer les opérations spécifiées dans les instructions et de ne jamais toucher à
une zone non spécifiée dans les instructions.
Tout mouvement brusque de la machine peut entraîner des blessures ou des brûlures.

AVERTISSEMENT

N’utilisez jamais de solvant comme de l’essence, de l’alcool ou un diluant pour effectuer le net-
toyage.
Cela pourrait provoquer un incendie.

AVERTISSEMENT

Nettoyage de la machine

Essuyez la saleté et la crasse avec un chiffon humidifié à l’eau, puis essorez fermement.

Mettez la machine hors tension avant de la nettoyer.

IMPORTANT

Abaissez le levier de chargement avant le nettoyage.

IMPORTANT

Nettoyage
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Rouleau-pinceur Tenez le rouleau avec votre main de façon à ce qu’il ne tourne pas, et essuyez la
saleté et les restes de matériau de la partie en caoutchouc du rouleau-pinceur. En-
suite, nettoyez avec un chiffon sec.

Affichage Essuyez-le avec un chiffon sec.

Rouleau abrasif Après avoir soulevé tous les rouleaux-pinceurs, faites tourner le rouleau abrasif en
utilisant une brosse. Utilisez *1 pour enlever la poussière de la surface.

 

*1 N’utilisez pas de brosse métallique.
 

Nettoyage
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Nettoyage du captop du porte-lame

Lorsqu’un porte-lame a été utilisé pendant une longue période, le roulement qui supporte la lame se dété-
riore, ce qui rend la rotation de la lame plus difficile. Si vous continuez à utiliser le porte-lame ainsi, la
machine ne coupera pas proprement car la pointe de la lame ne tournera plus en douceur.

Si l’une des conditions suivantes apparaît, nettoyez le captop du porte-lame.

• Les coins et les courbes ne sont pas propres

• Les lignes de coupe sont perforées

Ne jamais toucher l’extrémité du couteau.
Vous risqueriez de vous blesser. La performance de coupe de la lame sera également altérée.

ATTENTION

Desserrez le captop pour l’enlever et retirez toute accumulation de matériau ou de poussière à l’intérieur.

Si le nettoyage n’améliore pas les conditions, remplacez le porte-lame par un nouveau.

RAPPEL

 LIENS CONNEXES 

Nettoyage
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・  P. 286 Remplacement de la lame

Nettoyage
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Pour acheter des consommables, visitez le site Web de DGSHAPE Corporation ou contactez votre revendeur
DGSHAPE Corporation agréé.

 LIENS CONNEXES 

・ https://www.rolanddg.co.jp/

Lame

Lame

Dans les cas ci-dessous, la lame a atteint la fin de sa durée de vie. Remplacez-la par une nouvelle.

• La pointe de la lame est cassée.

• Des zones non coupées restent même si la force de la lame a été augmentée à 50 ou 60 gf.

• Les coupes ne sont plus aussi nettes qu’avant

• Le matériau commence à s’enrouler sur la base papier lors de la découpe de zones détaillées ou de
coins

La pointe d’une lame qui a été utilisée pendant une longue période ou qui a été utilisée pour couper un
matériau dur peut s’user. Une lame qui s’est usée de cette manière ne coupera plus proprement, il faut
donc la remplacer par une nouvelle.

 LIENS CONNEXES 

・  P. 286 Remplacement de la lame

Remplacement de la lame

Si la lame s’émousse, remplacez-la par la lame de rechange fournie.

Assurez-vous d’effectuer les opérations spécifiées dans les instructions et de ne jamais toucher à
une zone non spécifiée dans les instructions.
Tout mouvement brusque de la machine peut entraîner des blessures ou des brûlures.

AVERTISSEMENT

Ne jamais toucher l’extrémité du couteau.
Vous risqueriez de vous blesser. La performance de coupe de la lame sera également altérée.

ATTENTION

Procédure

Pièces consommables

286  Nettoyage et pièces consommables

https://www.rolanddg.co.jp/


1. Retirez tout matériau chargé dans la machine.

2. Détachez le porte-lame.

3. Remplacement de la lame.

(1) Appuyez sur la broche pour faire sortir l’ancienne lame.

(2) Insérez une nouvelle lame.

4. Installez le porte-lame dans le chariot de coupe.

5. Assurez-vous que la vis est bien serrée.

 LIENS CONNEXES 

・  P. 173 Retrait du matériau

・  P. 201 Ajustement de la profondeur de coupe

Pièces consommables
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Porte-lame

Porte-lame

Si la coupe est effectuée avec la pointe de la lame ajustée, le capuchon du porte-lame et le matériau frot-
tent l’un contre l’autre, ce qui use progressivement la pointe du capuchon.Une usure importante empêche
le réglage correct de la pointe de la lame, ce qui empêche une coupe propre. Dans ce cas, remplacez le
porte-lame par un nouveau.

 LIENS CONNEXES 

・  P. 284 Nettoyage du captop du porte-lame

Protecteur de lame

Protecteur de lame

Si la découpe est effectuée alors que l’extension de la lame ou sa force ne sont pas correctement réglées,
la pointe de la lame peut percer la base papier du matériau et rayer le protecteur de lame. Si la coupe est
réalisée alors que le protecteur de lame est rayé, les coupes effectuées risquent de ne pas être nettes.

Dans les cas ci-dessous, remplacez le protecteur de lame.

• La surface du protecteur de lame est déformée en raison d’une rayure ou d’un dommage similaire.

• Il s’est détérioré au point de tomber en morceau

 LIENS CONNEXES 

・ https://www.rolanddg.co.jp/

Pièces consommables
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 LIENS CONNEXES 

・  P. 222 Ajustement de la position de coupe

・  P. 224 Ajustement de la position d’impression

Est-ce que le matériau utilisé est épais ?

Quand vous utilisez un matériau épais, réglez "QUALITE" sur "LOURD".

 LIENS CONNEXES 

・  P. 205 Configuration de la vitesse de coupe

Est-ce que la machine est réglée pour faire avancer une certaine quantité de
matériau avant la coupe ?

Quand vous utilisez un matériau en rouleau ou un matériau plat de plus de 1,6 m, si la coupe est effectuée
sans que la longueur de matériau requise pour les données de découpe soit alimentée, le matériau peut
glisser ou le fonctionnement peut s’arrêter en raison d’une erreur du moteur.

Configurez la machine de manière à ce que la quantité nécessaire de matériau soit alimentée avant la cou-
pe.

 LIENS CONNEXES 

・  P. 40 Vérifier l’alimentation en matériaux

L’impression et la découpe sont mal alignées
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Est-ce que la lame et le porte-lame sont bien installés ?

Assurez-vous que les vis sont bien serrées pour qu’elles ne se détachent pas pendant la coupe.

 LIENS CONNEXES 

・  P. 286 Remplacement de la lame

Est-ce que la pointe de la lame est cassée ?

Si c’est le cas, remplacez la lame par une nouvelle.

 LIENS CONNEXES 

・  P. 286 Remplacement de la lame

Est-ce qu’il y a une accumulation de poussière ou d’adhésif sur la pointe de la
lame ?

Retirez et nettoyez la lame.

 LIENS CONNEXES 

・  P. 286 Remplacement de la lame

Y a-t-il une accumulation de morceaux de matériau ou de poussière à l’inté-
rieur du porte-lame ?

Retirez l’extrémité du porte-lame et enlevez les morceaux de matériau ou la poussière qui se trouvent à
l’intérieur.

 LIENS CONNEXES 

・  P. 284 Nettoyage du captop du porte-lame

Est-ce que le matériau utilisé est épais ?

Quand vous utilisez un matériau épais, réglez "QUALITE" sur "LOURD".

 LIENS CONNEXES 

・  P. 205 Configuration de la vitesse de coupe

Est-ce que la force de la lame et la vitesse de coupe sont appropriées ?

Effectuez des tests de découpe et ajustez les réglages jusqu’à ce que la coupe puisse être effectuée de
manière appropriée.

Il reste des zones non coupées ou les bords
coupés ne sont pas nets
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 LIENS CONNEXES 

・  P. 203 Configuration de la force de la lame

・  P. 212 Réglage de la vitesse de la lame pendant la coupe

・  P. 45 Réaliser un test de découpe

Est-ce que le décalage de la pointe de la lame est approprié ?

Si le réglage du décalage n’est pas correct pour la pointe de la lame, les coins peuvent être arrondis ou
cornés.

Définissez une valeur appropriée pour le décalage de la pointe de la lame.

 LIENS CONNEXES 

・  P. 206 Réglage du décalage de la pointe de la lame

Est-ce que la machine est réglée pour faire avancer une certaine quantité de
matériau avant la coupe ?

Quand vous utilisez un matériau en rouleau ou un matériau plat de plus de 1,6 m, si la coupe est effectuée
sans que la longueur de matériau requise pour les données de découpe soit alimentée, le matériau peut
glisser ou le fonctionnement peut s’arrêter en raison d’une erreur du moteur.

Configurez la machine de manière à ce que la quantité nécessaire de matériau soit alimentée avant la cou-
pe.

 LIENS CONNEXES 

・  P. 40 Vérifier l’alimentation en matériaux

Est-ce que "LISSAGE" est réglé sur "NON" ?

Pour couper les courbes proprement, réglez "LISSAGE" sur "OUI".

 LIENS CONNEXES 

・  P. 213 Découpage en douceur des arcs et autres courbes (Lissage)

Est-ce que le protecteur de lame est endommagé ou déformé ?

Si le protecteur de lame est endommagé, le matériau peut ne pas être coupé correctement même si les
réglages de la machine et l’installation de la lame et du porte-lame sont tous corrects. Si cela se produit,
contactez votre revendeur Roland DG Corporation agréé.

 LIENS CONNEXES 

・  P. 288 Protecteur de lame

Il reste des zones non coupées ou les bords coupés ne sont pas nets
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Est-ce que l’ajustement de la pointe de la lame et la force de la lame sont ap-
propriés au matériau à couper ?

Effectuez un test de découpe et réglez la pointe et la force de la lame de manière appropriée.

 LIENS CONNEXES 

・  P. 200 Guide général concernant les conditions de coupe

・  P. 45 Réaliser un test de découpe

・  P. 201 Ajustement de la profondeur de coupe

La machine coupe la base papier
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Est-ce que [Overlap Cutting] est réglée sur [0] dans CutStudio ?

Si [Overlap Cutting] est réglée sur un nombre différent de [0] sur l’écran de [Cut], ce nombre est ajouté
au nombre de coupes. Configurez [Overlap Cutting] sur [0], ou configurez [SUPERPOSITION] sur [NON] sur
la machine.

 LIENS CONNEXES 

・  P. 82 Découpe

Est-ce que le paramètre [OVERLAP] de la machine est un nombre compris en-
tre 1 et 10 ?

Réglez le paramètre "SUPERPOSITION" de la machine sur "NON".

 LIENS CONNEXES 

・  P. 214 Couper à la même position de façon répétitive (Superposition)

Est-ce que des lignes se superposent ?

Les mêmes données peuvent avoir été copiées, ce qui entraîne une superposition des lignes. Vérifiez les
données.

La machine coupe la même zone deux fois
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Lorsque la machine ne peut pas lire les repères de découpe, elle affiche le message d’erreur suivant et
s’arrête.

• "SET TO <TOOL MODE>"

• "ERREUR LONGUEUR"

• "ERREUR LARGEUR"

• "ANGLE TROP GRAND"

Si cela se produit, appuyez sur n’importe quelle touche du panneau de commande. Retirez le matériau,
vérifiez les éléments suivants, puis rechargez le matériau.

Est-ce que le matériau est chargé correctement ?

Assurez-vous que le matériau est chargé et mis en place correctement.

 LIENS CONNEXES 

・  P. 27 Mise en place du matériau

Est-ce que vous utilisez des matériaux qui ne sont pas blancs ou qui sont bril-
lants ?

Les repères de découpe ne peuvent pas être détectés si des décorations ou des couleurs sont présentes sur
le matériau. Les repères de découpe ne peuvent pas non plus être détectés sur un matériau brillant, mê-
me s’il est blanc.

Préparez un matériau blanc et mat (peu brillant) et recommencez le processus depuis l’étape d’impres-
sion.

 LIENS CONNEXES 

・  P. 15 Conditions des matériaux utilisables

Est-ce que vous utilisez un matériau transparent ?

Les repères de découpe ne peuvent pas être détectés sur un matériau transparent. Changez le matériau
que vous utilisez.

 LIENS CONNEXES 

・  P. 15 Conditions des matériaux utilisables

Est-ce que le matériau présente des plis ou des froissements ?

Les repères de découpe peuvent ne pas être lus si le matériau présente des plis ou des froissements.

Étirez les plis ou les froissements et chargez à nouveau le matériau. Si les repères de découpe ne sont tou-
jours pas lisibles, préparez un nouveau matériau sans froissements et recommencez l’opération d’impres-
sion des données.

Les repères de découpe ne sont pas détectés
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Est-ce que les repères de découpe sont flous ou d’une autre couleur que le
noir ?

Réglez la couleur des repères de découpe sur le noir, spécifiez une densité d’impression de 100 % sur votre
imprimante, puis imprimez à nouveau les données.

 LIENS CONNEXES 

・  P. 17 Repères de découpe

Est-ce que la taille et la forme des repères de découpe sont correctes ?

La machine ne peut détecter que les repères de découpe avec la forme prescrite.

Faites les repères de découpe sous la forme de cercles parfaits de 10 mm de diamètre.

 LIENS CONNEXES 

・  P. 17 Repères de découpe

Est-ce que les repères de découpe sont bien placés ?

Placez les repères de découpe aux bonnes positions.

 LIENS CONNEXES 

・  P. 342 Marges et distance entre les repères de découpe

Est-ce que le menu "ROTAT." est réglé sur "90deg" ?

Lorsque vous utilisez des repères de découpe, veillez à régler le menu "ROTAT." sur "0deg". Les repères de
découpe ne peuvent pas être lus si elles sont configurées sur "90deg".

 LIENS CONNEXES 

・  P. 208 Définir l’orientation des coordonnées de coupe

Est-ce que la machine est exposée à la lumière directe du soleil ou à un fort
éclairage intérieur ?

Si le capteur du chariot de coupe est exposé à la lumière directe du soleil ou à un éclairage intérieur, les
repères de découpe peuvent ne pas être détectés.

Déplacez la machine dans un emplacement où elle n’est pas exposée à la lumière directe du soleil ou à un
éclairage intérieur.

Si le problème n’est pas résolu même après avoir suivi les étapes ci-dessus, effectuez un alignement avec
"TOOL MODE".

 LIENS CONNEXES 

・  P. 178 Imprimer et Couper en mode Outil

Les repères de découpe ne sont pas détectés
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Est-ce que le matériau est chargé, droit, et sécurisé ? Est-ce que les résultats
de l’impression sont de travers ?

Les repères de découpe ne peuvent pas être détectés dans les cas suivants : Assurez-vous que le matériau
est chargé ou imprimé avec des repères de découpe droits.

• Les repères de découpe gauche et droit sont inclinés de 5 degrés ou plus par rapport au sens de dépla-
cement du chariot de coupe.

• Les repères de découpe sont décalés de 20 mm dans le sens de l’alimentation du matériau.

 LIENS CONNEXES 

・  P. 73 Chargement du matériau imprimé

Est-ce que les distances entre les repères de découpe spécifiée par le logiciel
correspondent-elles à celles spécifiées sur la machine ? (Mode manuel)

Sur la machine, réglez correctement la distance spécifiée par le logiciel.

 LIENS CONNEXES 

・  P. 190 Configuration de la méthode d’alignement (mode manuel)

Est-ce que l’impression est agrandie ou réduite ?

Si le format est agrandi ou réduit pendant l’impression, les repères de découpe ne peuvent pas être lus
pendant la coupe.

Imprimez les données en spécifiant 100 % pour l’agrandissement.

Les repères de découpe ne sont pas détectés
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Est-ce que le levier de chargement est abaissé ?

Si c’est le cas, le matériau n’est pas fixé à sa place. Vérifiez que les rouleaux-pinceurs se trouvent à l’in-
térieur des bords du matériau, puis relevez le levier de chargement.

Est-ce que le matériau est chargé parallèlement aux lignes guide ?

Utilisez un matériau dont les bords gauche et droit sont parallèles, et alignez le bord gauche du matériau
de manière à ce qu’il soit parallèle aux lignes guide.

 LIENS CONNEXES 

・  P. 27 Position de chargement du matériau

Est-ce que le matériau touche un obstacle pendant la découpe ?

Veillez à ce que les bords gauche et droit du matériau n’entrent pas en contact avec les surfaces internes
de la machine pendant la découpe. Un tel contact n’endommage pas seulement le matériau, mais entrave
également l’alimentation normale du matériau et le fait glisser hors de sa position.

Est-ce que la découpe a été effectuée sans vérifier l’alimentation du maté-
riau ? (matériau en rouleau)

Si vous commencez la découpe sans vérifier l’avance du matériau, vous risquez de ne pas obtenir des ré-
sultats de découpe corrects. Dans le pire des cas, cela peut provoquer une erreur, un dysfonctionnement
ou endommager le matériau.

 LIENS CONNEXES 

・  P. 40 Vérifier l’alimentation en matériaux

Est-ce que les rouleaux-pinceurs sont utilisés pour fixer les deux bords du ma-
tériau ?

Si les rouleaux-pinceurs ne sont pas placés dans la plage des rouleaux abrasifs, le matériau n’est pas fixé,
ce qui l’empêche d’être alimenté correctement.

Rechargez le matériau.

 LIENS CONNEXES 

・  P. 27 Position de chargement du matériau

Le matériau glisse des rouleaux-pinceurs pen-
dant la coupe
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Est-ce que les câbles sont connectés correctement ?

Vérifiez que le cordon d’alimentation, le câble USB et le câble Ethernet sont correctement connectés.

Lorsqu’un câble USB et un câble Ethernet sont connectés en même temps, il arrive que la machine ne
fonctionne pas. Ne connectez qu’un seul de ces câbles.

Est-ce que l’alimentation est coupée ?

Mettez la machine sous tension.

 LIENS CONNEXES 

・  P. 20 Mise sous tension

Est-ce que le matériau est préparé ?

Lorsque l’écran ci-dessous est affiché, la découpe n’est pas disponible, même si des données sont envoy-
ées.

Sélectionnez le matériau chargé, puis appuyez sur [ENTER] pour terminer la configuration.

SELECT SHEET
ROLL

 LIENS CONNEXES 

・  P. 27 Mise en place du matériau

Est-ce que les paramètres de l’application logicielle sont incorrects ?

Sélectionnez le pilote approprié pour la machine. Pour la procédure de sélection, reportez-vous au manuel
du logiciel d’application.

La machine ne fonctionne pas
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Est-ce que vous avez maintenu le bouton d’alimentation enfoncé pendant une
seconde ou plus ?

Appuyez sur le bouton d’alimentation pendant 1 seconde ou plus pour mettre la machine hors tension. Si
la machine refuse encore de se mettre hors tension, débranchez la prise secteur de la machine.

L’alimentation ne peut pas être coupée
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Est-ce que le matériau alimenté fait 1,6 m ou plus ?

Si un matériau plat de plus de 1,6 m est chargé avec "FEUILLE", la machine le reconnaît comme un rou-
leau.

 LIENS CONNEXES 

・  P. 15 Types de matériaux

Impossible de préparer le matériau de coupe
avec "FEUILLE"
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Connexion via un câble USB

Vous pouvez connecter jusqu’à cinq unités GS2-24 à un seul ordinateur. Lorsque vous connectez plusieurs
unités GS2-24 via une connexion USB, vous devez modifier le numéro USB de chaque machine pour pouvoir
distinguer les destinations de sortie. Le paramètre par défaut de la machine est "A". Quand vous connectez
deux machines ou plus, la deuxième machine et chaque machine suivante doivent être configurées avec un
paramètre différent de "A" pour que la machine puisse distinguer la destination de sortie des données.

Effectuez les procédures 1 à 3 pour établir une connexion. La même procédure peut être utilisée pour con-
necter une troisième unité ou une unité supplémentaire.

Étape 1: Changer le numéro USB de la machine

Ne connectez pas encore la machine à l’ordinateur avec le câble USB. Cela pourrait nuire à l’application correcte des
paramètres.

IMPORTANT

Procédure

1. Coupez l’alimentation de la machine.

2. Appuyez sur [TEST] et sur le bouton d’alimentation en même temps.

L’écran ci-dessous apparaît.

USB NUMBER [A]
*A

3. Appuyez sur [▲] et [▼] pour sélectionner un paramètre autre que "A".

Il est possible de sélectionner une valeur de "B" à "E". Dans cet exemple, "B" est sélectionné.

4. Appuyez sur [ENTER].

5. Mettez la machine hors tension, puis à nouveau sous tension.

L’écran ci-dessous apparaît. Vérifiez que la lettre que vous avez définie à la procédure 3 est affi-
chée.

Roland GS2-24
[B]  Main:V***

Connexion de plus d’une machine à un ordina-
teur (Windows)
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Étape 2: Modifier les paramètres d’impression de l’ordinateur

Procédure

1. Connectez la machine à l’ordinateur avec le câble USB.

Le pilote est installé.

2. Ouvrir [Devices And Printers].

• Windows 11

a. Cliquez sur [Start]>[Toutes les applications]>[Outil Windows].

b. Double-cliquez sur [Contorol Panel].

c. Cliquez sur [Périphériques et imprimantes].

• Windows 10

a. Cliquez sur [Start]>[Système Windows]>[Contorol Panel].

b. Cliquez sur [Périphériques et imprimantes].

• Windows 8.1

a. Pointez dans le coin inférieur droit de l’écran pour afficher les charmes, puis cliquez sur
[Paramètres].

b. Cliquez sur [Contorol Panel].

c. Cliquez sur [Matériel et audio]>[Périphériques et imprimantes].

[Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)]) est créé.

3. Faites un clic droit sur [Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)], et sélectionnez [Printer
Properties].

4. Remplacez [Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)]) par [Roland DG GS2-24 (B)].

5. Cliquez sur [OK].

Connexion de plus d’une machine à un ordinateur (Windows)
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Étape 3: Vérifier que le 2e GS2-24 a été installé

Procédure

1. Lancez CutStudio.

2. Cliquez sur [File]>[Cutting Setup].

3. Cliquez sur le [Printer Name].

Si [Roland DG GS2-24 (B)] est indiqué, la 2e machine est correctement connectée.

Connexion de plus d’une machine à un ordinateur (Windows)
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Connexion via Ethernet

Vous pouvez connecter jusqu’à cinq unités GS2-24 à un seul ordinateur. Lorsque vous connectez plusieurs
machines à un ordinateur en utilisant Ethernet, installez un pilote au fur et à mesure que vous ajoutez
chaque machine.

Effectuez les procédures 1 à 3 pour établir une connexion. La même procédure peut être utilisée pour con-
necter une troisième unité ou une unité supplémentaire.

Étape 1: Installation du pilote de la machine à ajouter

Procédure

1. Connectez la machine à ajouter au même réseau local que l’ordinateur avec un câble Ethernet.

2. Installez le pilote sur l’ordinateur.

Reportez-vous à la section « Installation du logiciel avec l’adresse IP définie automatiquement » du
manuel « Installation et premiers réglages Version Windows » (https://downloadcen-
ter.rolanddg.com/GS2-24), et installez le pilote sur l’ordinateur.

Connexion de plus d’une machine à un ordinateur (Windows)
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Étape 2: Modifier les paramètres d’impression de l’ordinateur

Procédure

1. Ouvrir [Devices And Printers].

• Windows 11

a. Cliquez sur [Start]>[Toutes les applications]>[Outil Windows].

b. Double-cliquez sur [Contorol Panel].

c. Cliquez sur [Périphériques et imprimantes].

• Windows 10

a. Cliquez sur [Start]>[Système Windows]>[Contorol Panel].

b. Cliquez sur [Périphériques et imprimantes].

• Windows 8.1

a. Pointez dans le coin inférieur droit de l’écran pour afficher les charmes, puis cliquez sur
[Paramètres].

b. Cliquez sur [Contorol Panel].

c. Cliquez sur [Matériel et audio]>[Périphériques et imprimantes].

[Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)]) est créé.

2. Faites un clic droit sur [Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)], et sélectionnez [Printer
Properties].

3. Remplacez [Roland DG GS2-24 (1)] (ou [Roland DG GS2-24 (1 copie)]) par [Roland DG GS2-24 (B)].

4. Cliquez sur [OK].

Connexion de plus d’une machine à un ordinateur (Windows)
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Étape 3: Vérifier que le 2e GS2-24 a été installé

Procédure

1. Lancez CutStudio.

2. Cliquez sur [File]>[Cutting Setup].

3. Cliquez sur le [Printer Name].

Si [Roland DG GS2-24 (B)] est indiqué, la 2e machine est correctement connectée.

Connexion de plus d’une machine à un ordinateur (Windows)
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Il n’est pas possible de connecter plusieurs machines à un ordinateur via USB.
Pour connecter plusieurs machines, changez l’USB pour utiliser Ethernet pour la connexion entre l’ordinateur et chaque
machine.

RAPPEL

Connexion via Ethernet (réglage manuel de l’adresse IP)

Avec un ordinateur Macintosh, utilisez un plug-in Adobe Illustrator pour envoyer sur la machine. Lorsque
vous connectez plusieurs machines à un ordinateur, établissez des connexions Ethernet entre l’ordinateur
et chaque machine.

Étape 1: Connecter les câbles LAN

Procédure

1. Démarrez l’ordinateur.

2. Appuyez sur le bouton d’alimentation pour démarrer la machine à connecter.

3. Connectez la machine et l’ordinateur avec un câble LAN.

Connexion de plus d’une machine à un ordina-
teur (Mac)
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Étape 2: Configuration de l’adresse IP de la machine à connecter

Procédure

1. Déterminez l’adresse IP de la machine.

Vérifiez l’adresse IP de l’ordinateur pour déterminer l’adresse IP de la machine.

Quand l’adresse IP de l’ordinateur est 192.168.0.xxx

• Adresse IP de la machine : 192. 168. 0. yyy

Saisissez un nombre de 1 à 254 pour [yyy]. Assurez-vous qu’ils sont différents des numéros des
autres équipements du réseau.

2. Si la machine est éteinte, appuyez sur le bouton d’alimentation pour démarrer la machine.

3. Appuyez deux fois sur [MENU] pour afficher l’écran illustré ci-dessous.

CONDITION

4. Appuyez une fois sur [▼] pour afficher l’écran illustré ci-dessous.

SYSTEM INFO.

5. Appuyez une fois sur [▶] pour afficher l’écran illustré ci-dessous.

SYSTEM INFO.
MODEL

6. Appuyez trois fois sur [▼] pour afficher l’écran ci-dessous.

SYSTEM INFO.
INTERFACE

7. Appuyez deux fois sur [▶] pour afficher l’écran illustré ci-dessous.

NETWORK
DHCP ON

Connexion de plus d’une machine à un ordinateur (Mac)
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8. Appuyez sur [▶], puis sur [▼] pour régler DHCP sur OFF.

DHCP ON
 OFF

9. Appuyez sur [ENTER].

10. Appuyez une fois sur [▼] pour afficher l’écran illustré ci-dessous.

NETWORK
IP ADDRESS

11. Appuyez deux fois sur [▶].

a. Appuyez sur [▲] ou [▼] pour saisir l’adresse IP de la machine que vous avez déterminée à la
procédure 1.

Appuyez sur [◀] ou [▶] pour déplacer le curseur.

b. Appuyez sur [ENTER].

12. Appuyez sur [MENU] pour revenir à l’écran d’origine.

13. Répétez les procédures 1 à 12 pour définir l’adresse IP de la deuxième machine.

Connexion de plus d’une machine à un ordinateur (Mac)
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Étape 3: Configuration des paramètres de sortie du plug-in Adobe Illustrator

Procédure

1. Lancez Adobe Illustrator.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.

3. Sélectionnez [GS2-24] dans la liste [Model].

Connexion de plus d’une machine à un ordinateur (Mac)
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4. Cliquez sur , puis sélectionnez [Connection].

5. Sélectionnez [IP], puis saisissez l’adresse IP que vous avez déterminée à la procédure 1 de [Étape 2 :
Configuration de l’adresse IP de la machine à connecter].

Exemple :

Si l’adresse IP de la machine est [192.168.000.061], saisissez [192.168.0.61].

6. Cliquez sur [Vérifier].

Si la connexion avec la machine est établie avec succès, [Success!] apparaît.

Si [Failed.] apparaît, vérifiez si l’adresse IP a été saisie correctement.

7. Cliquez sur [OK].

8. Répétez les procédures 4 à 7 pour configurer la connexion de la deuxième machine.

Vous pouvez modifier la machine qui émettra les données en saisissant l’adresse IP de la machine qui émettra
vers le plug-in Adobe Illustrator.

RAPPEL

Connexion de plus d’une machine à un ordinateur (Mac)
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Connexion via Ethernet (réglage automatique de l’adresse IP)

Avec un ordinateur Macintosh, utilisez un plug-in Adobe Illustrator pour envoyer sur la machine. Lorsque
vous connectez plusieurs machines à un ordinateur, établissez des connexions Ethernet entre l’ordinateur
et chaque machine.

Étape 1: Connecter les câbles LAN

Procédure

1. Démarrez l’ordinateur.

2. Appuyez sur le bouton d’alimentation pour démarrer la machine à connecter.

3. Connectez la machine et l’ordinateur avec un câble LAN.

Connexion de plus d’une machine à un ordinateur (Mac)
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Étape 2: Vérification des paramètres de la machine à connecter

Procédure

1. Si la machine est éteinte, appuyez sur le bouton d’alimentation pour démarrer la machine.

2. Appuyez deux fois sur [MENU] pour afficher l’écran illustré ci-dessous.

CONDITION

3. Appuyez une fois sur [▼] pour afficher l’écran illustré ci-dessous.

SYSTEM INFO.

4. Appuyez une fois sur [▶] pour afficher l’écran illustré ci-dessous.

SYSTEM INFO.
MODEL

5. Appuyez trois fois sur [▼] pour afficher l’écran ci-dessous.

SYSTEM INFO.
INTERFACE

6. Appuyez deux fois sur [▶] pour afficher l’écran illustré ci-dessous.

NETWORK
DHCP ON

Si DHCP est réglé sur OFF, appuyez sur [▶], puis sur [▼] pour régler DHCP sur ON, puis appuyez sur
[ENTER].

7. Appuyez une fois sur [▼] pour afficher l’écran illustré ci-dessous.

NETWORK
IP ADDRESS

Connexion de plus d’une machine à un ordinateur (Mac)
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8. Appuyez une fois sur [▶].

9. Notez l’adresse IP affichée.

10. Appuyez sur [MENU] pour revenir à l’écran d’origine.

11. Répétez les procédures 1 à 10 pour vérifier les réglages de la deuxième machine.

Connexion de plus d’une machine à un ordinateur (Mac)
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Étape 3: Configuration des paramètres de sortie du plug-in Adobe Illustrator

Procédure

1. Lancez Adobe Illustrator.

2. Cliquez sur [Window]>[Extensions]>[Roland CutStudio].

La palette [Roland CutStudio] apparaît.

3. Sélectionnez [GS2-24] dans la liste [Model].

Connexion de plus d’une machine à un ordinateur (Mac)
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4. Cliquez sur , puis sélectionnez [Connection].

5. Sélectionnez [IP], puis saisissez l’adresse IP que vous avez notée à la procédure 9 de [Étape 2 : Vérifica-
tion des paramètres de la machine à connecter].

Exemple :

Si l’adresse IP de la machine est [192.168.000.061], saisissez [192.168.0.61].

6. Cliquez sur [Vérifier].

Si la connexion avec la machine est établie avec succès, [Success!] apparaît.

Si [Failed.] apparaît, vérifiez si l’adresse IP a été saisie correctement.

7. Cliquez sur [OK].

8. Répétez les procédures 4 à 7 pour configurer la connexion de la deuxième machine.

Vous pouvez changer la destination de la sortie en sélectionnant l’adresse IP de la machine vers laquelle la
sortie doit être effectuée avec l’option [Connection] du plug-in Adobe Illustrator.

RAPPEL

Connexion de plus d’une machine à un ordinateur (Mac)
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Si vous avez annulé l’installation ou si la connexion du câble USB ne lance pas l’assistant, suivez la procé-
dure indiquée ci-dessous pour installer le pilote.

Réinstaller le pilote (Windows 8.1)

Procédure

1. Connectez la machine à l’ordinateur à l’aide du câble USB et mettez la machine sous tension.

2. Si le message [Nouveau matériel détecté] apparaît, cliquez sur [Fermer] pour le fermer.

Débranchez le câble USB de toutes les imprimantes, sauf celui de la machine.

3. Pointez dans le coin inférieur droit de l’écran pour afficher les charmes, puis cliquez sur [Panneau de
configuration]>[Matériel et audio].

4. Cliquez sur [Panneau de configuration], puis sur [Périphériques et imprimantes].

5. Cliquez sur [Gestionnaire de périphériques]. Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affi-
che, cliquez sur [Oui] (ou [Autoriser]).

Le [Gestionnaire de périphériques] apparaît.

6. Dans le menu [Affichage], cliquez sur [Afficher les périphériques cachés].

7. Recherchez dans la liste les [Imprimantes] ou les [Autres périphériques], puis double-cliquez dessus.

Le nom de votre machine ou du [Périphérique inconnu] apparaît sous l’élément sélectionné. Cli-
quez sur le nom pour le sélectionner.

8. Dans le menu [Action], cliquez sur [Désinstaller].

9. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

10. Fermez le [Gestionnaire de périphériques].

11. Débranchez le câble USB de l’ordinateur, puis redémarrez Windows.

12. Désinstallez le pilote en suivant la procédure ci-dessous.

P. 324Désinstallation du pilote (Windows 8.1)

13. Commencez l’installation depuis le début en suivant la procédure ci-dessous.

GS2-24 Installation and Initial Settings Windows Version

L’installation du pilote est impossible
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Réinstaller le pilote (Windows 10)

Procédure

1. Connectez la machine à l’ordinateur à l’aide du câble USB et mettez la machine sous tension.

2. Si le message [Nouveau matériel détecté] apparaît, cliquez sur [Fermer] pour le fermer.

Débranchez le câble USB de toutes les imprimantes, sauf celui de la machine.

3. Faites un clic droit sur le bouton [Démarrer], puis cliquez sur [Gestionnaire de périphériques].

4. Dans le menu [Affichage], cliquez sur [Afficher les périphériques cachés].

5. Recherchez dans la liste les [Imprimantes] ou les [Autres périphériques], puis double-cliquez dessus.

Le nom de votre machine ou du [Périphérique inconnu] apparaît sous l’élément sélectionné. Cli-
quez sur le nom pour le sélectionner.

6. Dans le menu [Action], cliquez sur [Désinstaller l’appareil].

7. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

8. Fermez le [Gestionnaire de périphériques].

9. Débranchez le câble USB de l’ordinateur, puis redémarrez Windows.

10. Désinstallez le pilote en suivant la procédure ci-dessous.

P. 325Désinstallation du pilote (Windows 10)

11. Commencez l’installation depuis le début en suivant la procédure ci-dessous.

GS2-24 Installation and Initial Settings Windows Version

L’installation du pilote est impossible
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Réinstaller le pilote (Windows 11)

Procédure

1. Connectez la machine à l’ordinateur à l’aide du câble USB et mettez la machine sous tension.

2. Si le message [Nouveau matériel détecté] apparaît, cliquez sur [Fermer] pour le fermer.

Débranchez le câble USB de toutes les imprimantes, sauf celui de la machine.

3. Faites un clic droit sur le bouton [Démarrer], puis cliquez sur [Gestionnaire de périphériques].

4. Dans le menu [Affichage], cliquez sur [Afficher les périphériques cachés].

5. Recherchez dans la liste les [Imprimantes] ou les [Autres périphériques], puis double-cliquez dessus.

Le nom de votre machine ou du [Périphérique inconnu] apparaît sous l’élément sélectionné. Cli-
quez sur le nom pour le sélectionner.

6. Dans le menu [Action], cliquez sur [Désinstaller l’appareil].

7. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

8. Fermez le [Gestionnaire de périphériques].

9. Débranchez le câble USB de l’ordinateur, puis redémarrez Windows.

10. Désinstallez le pilote en suivant la procédure ci-dessous.

P. 325Désinstallation du pilote (Windows 10)

11. Commencez l’installation depuis le début en suivant la procédure ci-dessous.

GS2-24 Installation and Initial Settings Windows Version

L’installation du pilote est impossible
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Pour désinstaller le pilote, suivez la procédure ci-dessous.

Désinstallation du pilote (Windows 8.1)

Procédure

1. Éteignez la machine, puis débranchez le câble de connexion entre l’ordinateur et la machine.

2. Démarrer Windows.

3. Cliquez sur [Bureau].

4. Pointez dans le coin inférieur droit de l’écran pour afficher les charmes, puis cliquez sur [Paramètres].

5. Cliquez sur [Panneau de configuration]>[Désinstaller un programme].

6. Faites un clic droit sur le pilote de la machine à supprimer, puis cliquez sur [Désinstaller].

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

7. Si un message vous invitant à confirmer la suppression apparaît, cliquez sur [Oui].

8. Cliquez sur [Démarrer]>[Bureau].

9. Ouvrez l’Explorateur et ouvrez le dossier spécifié comme emplacement d’installation du pilote au mo-
ment du téléchargement.

10. Double-cliquez sur [SETUP64.EXE] (version 64 bits) ou [SETUP.EXE] (version 32 bits).

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

Le programme d’installation du pilote démarre.

11. Sélectionnez [Désinstaller], puis cliquez sur [Démarrer].

12. Si une fenêtre vous invitant à redémarrer l’ordinateur apparaît, cliquez sur [Oui].

13. Après le redémarrage de l’ordinateur, ouvrez à nouveau le Panneau de configuration, puis cliquez sur
[Afficher les périphériques et les imprimantes].

14. Si vous pouvez voir l’icône de la machine à supprimer, faites un clic droit dessus, puis cliquez sur [Sup-
primer le périphérique].

Désinstallation du pilote
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Désinstallation du pilote (Windows 10)

Procédure

1. Éteignez la machine, puis débranchez le câble de connexion entre l’ordinateur et la machine.

2. Connectez-vous à Windows en tant qu’administrateur de l’ordinateur.

3. Cliquez sur [Démarrer]>[Système Windows]>[Panneau de configuration]>[Désinstaller un programme].

4. Double-cliquez sur le pilote de la machine à supprimer, puis cliquez sur [Oui].

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

5. Si un message vous invitant à confirmer la suppression apparaît, cliquez sur [Oui].

6. Faites un clic droit sur le bouton [Démarrer], puis cliquez sur [Explorateur].

7. Ouvrez l’Explorateur et ouvrez le dossier spécifié comme emplacement d’installation du pilote au mo-
ment du téléchargement.

8. Double-cliquez sur [SETUP64.EXE] (version 64 bits) ou [SETUP.EXE] (version 32 bits).

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

Le programme d’installation du pilote démarre.

9. Sélectionnez [Désinstaller], puis cliquez sur [Démarrer].

10. Si une fenêtre vous invitant à redémarrer l’ordinateur apparaît, cliquez sur [Oui].

La désinstallation sera terminée après le redémarrage de l’ordinateur.

Désinstallation du pilote
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Désinstallation du pilote (Windows 11)

Procédure

1. Éteignez la machine, puis débranchez le câble de connexion entre l’ordinateur et la machine.

2. Connectez-vous à Windows en tant qu’administrateur de l’ordinateur.

3. Cliquez sur [Démarrer]>[Toutes les applications]>[Outil Windows].

4. Double-cliquez sur [Panneau de configuration].

5. Cliquez sur [Désinstaller un programme].

6. Double-cliquez sur le pilote de la machine à supprimer, puis cliquez sur [Oui].

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

7. Si un message vous invitant à confirmer la suppression apparaît, cliquez sur [Oui].

8. Faites un clic droit sur le bouton [Démarrer], puis cliquez sur [Explorateur].

9. Ouvrez l’Explorateur et ouvrez le dossier spécifié comme emplacement d’installation du pilote au mo-
ment du téléchargement.

10. Double-cliquez sur [SETUP64.EXE].

Lorsque la fenêtre [Contrôle de compte d’utilisateur] s’affiche, cliquez sur [Oui] (ou [Autori-
ser]).

Le programme d’installation du pilote démarre.

11. Sélectionnez [Désinstaller], puis cliquez sur [Démarrer].

12. Si une fenêtre vous invitant à redémarrer l’ordinateur apparaît, cliquez sur [Oui].

La désinstallation sera terminée après le redémarrage de l’ordinateur.

Désinstallation du pilote
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Si le pilote n’est pas installé correctement, le pilote installé sera répertorié comme [Non spécifié] sur
l’ordinateur. Dans ce cas, effectuez la procédure suivante pour réinstaller le pilote.

Le pilote ne peut pas être installé correctement (Windows 8.1)

Procédure

1. Connectez-vous à Windows en tant qu’administrateur de l’ordinateur.

2. Sur l’écran [Démarrer], cliquez sur [Bureau].

3. Déplacez le pointeur de la souris dans le coin inférieur droit de la fenêtre du bureau, puis déplacez légè-
rement le pointeur de la souris vers le haut.

La barre de charmes s’affiche sur le côté droit de l’écran.

4. Cliquez sur [Paramètres].

Le charme [Paramètres] apparaît sur le côté droit de l’écran.

5. Cliquez sur [Contorol Panel].

6. Cliquez sur [Devices And Printers].

7. Faites un clic droit sur le pilote de la machine utilisée, qui est classé dans la catégorie [Non spécifié],
puis cliquez sur [Propriétés].

Si la machine et l’ordinateur ne sont pas connectés, aucun pilote ne sera affiché dans [Non spéci-
fié]. Si aucun pilote ne s’affiche, mettez la machine sous tension et connectez-la à l’ordinateur.

8. Cliquez sur l’onglet [Matériel], puis double-cliquez sur le nom du modèle utilisé.

9. Cliquez sur [Modifier les paramètres] dans l’onglet [Général] pour masquer le bouton [Modifier les para-
mètres].

Si [Modifier les paramètres] ne s’affiche pas dès le début, passez à l’étape suivante.

10. Cliquez sur [Pilotes], puis sur [Supprimer].

11. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

Le pilote du modèle utilisé sera toujours affiché comme [Non spécifié] à ce stade.

12. Désinstallez le pilote.

P. 324Désinstallation du pilote (Windows 8.1)

13. Réinstallez le pilote.

GS2-24 Installation and Initial Settings Windows Version

Le pilote est affiché comme [Non spécifié] après
l’installation
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Le pilote ne peut pas être installé correctement (Windows 10)

Procédure

1. Connectez-vous à Windows en tant qu’administrateur de l’ordinateur.

2. Cliquez sur [Start]>[Windows System]>[Contorol Panel].

3. Cliquez sur [Devices And Printers].

4. Faites un clic droit sur le pilote de la machine utilisée, qui est classé dans la catégorie [Non spécifié],
puis cliquez sur [Propriétés].

Si la machine et l’ordinateur ne sont pas connectés, aucun pilote ne sera affiché dans [Non spéci-
fié]. Si aucun pilote ne s’affiche, mettez la machine sous tension et connectez-la à l’ordinateur.

5. Cliquez sur l’onglet [Matériel], puis double-cliquez sur le nom du modèle utilisé.

6. Cliquez sur [Modifier les paramètres] dans l’onglet [Général] pour masquer le bouton [Modifier les para-
mètres].

Si [Modifier les paramètres] ne s’affiche pas dès le début, passez à l’étape suivante.

7. Cliquez sur l’onglet [Pilote], puis sur [Désinstaller l’appareil].

8. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

Le pilote du modèle utilisé sera toujours affiché comme [Non spécifié] à ce stade.

9. Désinstallez le pilote.

P. 325Désinstallation du pilote (Windows 10)

10. Réinstallez le pilote.

GS2-24 Installation and Initial Settings Windows Version

Le pilote est affiché comme [Non spécifié] après l’installation
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Le pilote ne peut pas être installé correctement (Windows 11)

Procédure

1. Connectez-vous à Windows en tant qu’administrateur de l’ordinateur.

2. Cliquez sur [Start]>[Toutes les applications]>[Outil Windows].

3. Double-cliquez sur [Contorol Panel].

4. Cliquez sur [Devices And Printers].

5. Faites un clic droit sur le pilote de la machine utilisée, qui est classé dans la catégorie [Non spécifié],
puis cliquez sur [Propriétés].

Si la machine et l’ordinateur ne sont pas connectés, aucun pilote ne sera affiché dans [Non spéci-
fié]. Si aucun pilote ne s’affiche, mettez la machine sous tension et connectez-la à l’ordinateur.

6. Cliquez sur l’onglet [Matériel], puis double-cliquez sur le nom du modèle utilisé.

7. Cliquez sur [Modifier les paramètres] dans l’onglet [Général] pour masquer le bouton [Modifier les para-
mètres].

Si [Modifier les paramètres] ne s’affiche pas dès le début, passez à l’étape suivante.

8. Cliquez sur l’onglet [Pilote], puis sur [Désinstaller l’appareil].

9. Dans la fenêtre [Confirmation de la désinstallation du périphérique], cliquez sur [OK].

Le pilote du modèle utilisé sera toujours affiché comme [Non spécifié] à ce stade.

10. Désinstallez le pilote.

P. 326Désinstallation du pilote (Windows 11)

11. Réinstallez le pilote.

GS2-24 Installation and Initial Settings Windows Version

Le pilote est affiché comme [Non spécifié] après l’installation
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Est-ce que les données sont enregistrées au format AI 8.0 ou EPS 8.0 ?

Lors de l’importation dans CutStudio de données créées dans Illustrator, il est uniquement possible d’im-
porter des fichiers Al 8.0 ou EPS 8.0. Si vous utilisez une version supérieure, enregistrez les fichiers dans
une version inférieure avant de les importer.

 LIENS CONNEXES 

・  P. 62 Placer les données d’impression

Impossible d’importer les données auprès d’Il-
lustrator
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Est-ce que l’ordinateur est configuré pour afficher les dossiers cachés ?

Emplacement du dossier de données d’échantillon

[Sample.bmp] trouvé dans le dossier d’installation de CutStudio (normalement situé dans [Program Fi-
les (x86)]>[CutStudio] sur le lecteur C)

Il se peut que les données échantillons ne s’affichent pas dans certains cas, selon les paramètres de l’ordi-
nateur. Lorsque cela se produit, effectuez le réglage suivant, et vérifiez à nouveau l’emplacement de stoc-
kage des données.

Procédure

1. Ouvrez l’[Explorateur].

Cliquez sur le dossier dans le coin inférieur gauche du bureau.

2. Cliquez sur l’onglet [Affichage].

3. Sélectionnez [Éléments masqués].

Impossible de trouver les données échantillons
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Cette section décrit les messages d’erreur qui peuvent apparaître sur l’écran de la machine et les mesures
à prendre pour remédier au problème. Si l’action décrite ici ne corrige pas le problème ou si un message
d’erreur non décrit ici apparaît, contactez votre revendeur Roland DG Corporation agréé.

"MAUVAIS COMMANDE"

La machine a reçu des données qu’elle ne peut pas interpréter.

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Examinez les données envoyées par
l’ordinateur, puis envoyez les données correctes.

"MAUVAIS NO.S"

Le nombre de paramètres est différent du nombre autorisé

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Examinez les données envoyées par
l’ordinateur, puis envoyez les données correctes.

"HORS CADRE"

La valeur du paramètre spécifié était en dehors de la plage autorisée.

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Examinez les données envoyées par
l’ordinateur, puis envoyez les données correctes.

"ERREUR ORIGINE"

La machine est exposée à la lumière directe du soleil ou à un fort éclairage intérieur et n’a pas pu
détecter l’origine immédiatement après la mise sous tension.

Mettez la machine hors tension et placez-la dans un endroit où elle ne sera pas exposée à la lumière direc-
te du soleil ou à une lumière intense. Puis, mettez-la sous tension.

"ERREUR CROPMARK"

La forme ou la couleur des repères de découpe, ou la couleur ou la brillance du matériau ne convien-
nent pas à la machine. Le problème peut également être dû à une défaillance mécanique.

La machine n’a pas pu lire les repères de découpe. Vérifiez la forme et la couleur des repères de découpe,
ainsi que la couleur et la brillance du matériau.

Si la même erreur se produit même après avoir vérifié la forme et la couleur des repères de découpe, ainsi
que la couleur et la brillance du matériau, contactez votre revendeur Roland DG Corporation agréé.

"ERREUR CROPMARK""ANGLE TROP GRAND"

Le repère de découpe 2 ou 3 est incliné de 5 degrés ou plus.

Messages d’erreur
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 : Repère de découpe 2

 : Repère de découpe 3

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Rechargez le matériau.

Messages d’erreur
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"ERREUR CROPMARK""ERREUR LONGUEUR"

Le repère de découpe 3 dévie de 20 mm ou plus dans le sens d’alimentation du matériau.

 : Repères de découpe 3

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Rechargez le matériau ou modifiez
la position du repère de découpe 3.

"ERREUR CROPMARK""ERREUR LARGEUR"

Le repère de découpe 2 dévie de 20 mm ou plus dans le sens du chariot de coupe.

 : Repère de découpe 2

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Rechargez le matériau ou modifiez
la position du repère de découpe 2

"HORS CADRE"

Ce message indique que les repères de découpe ou l’origine sont à l’extérieur du matériau.

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Vérifiez que les positions des repè-
res de découpe ou l’origine ne sont pas en dehors du matériau, et refaites les réglages.

"MEDIA NON CHARGE"

Une tentative a été faite pour que la machine soit prête sans chargement de matériau. Le matériau a
été retiré lorsque la machine était prête à effectuer la découpe. Le matériau a glissé pendant la dé-
coupe.

Appuyez sur n’importe quelle touche pour annuler la configuration et effacer le message d’erreur. Chargez
correctement le matériau, puis préparez-le pour la découpe (condition de préparation).

 LIENS CONNEXES 

・  P. 27 Position de chargement du matériau

Messages d’erreur
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"SET TO <SENSOR MODE>"

Les données de repères de découpe ont été envoyées quand la machine était en mode manuel.

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Passez les paramètres de la machi-
ne en mode Capteur, puis envoyez à nouveau les données.

 LIENS CONNEXES 

・  P. 77 Configurer le réglage pour effectuer un alignement automatique

"SET TO <TOOL MODE>"

Les repères de découpe n’ont pas pu être lus en mode Capteur.

Appuyez sur n’importe quelle touche pour effacer le message d’erreur. Passez les paramètres de la machi-
ne en mode Outil, puis envoyez à nouveau les données. Pour cela, utilisez quatre repères de découpe.
Lorsque la machine est en mode Outil, il n’est pas possible de couper en utilisant 3 repères de découpe.

Si vous souhaitez utiliser trois repères de découpe, laissez la machine en mode Capteur et modifiez la for-
me et la couleur des repères de découpe, ou la couleur et la brillance du matériau.

 LIENS CONNEXES 

・  P. 17 Repères de découpe/Repères d’outils

・  P. 296 Les repères de découpe ne sont pas détectés

"DONNEES SATUREES"

La quantité de données stockées dans la machine est trop importante et "RETRACER" ne peut être
exécutée

Procédure

1. Supprimez les données stockées dans la machine.

2. Réduisez la taille des données envoyées par l’ordinateur et renvoyez-les.

3. Effectuer un "RETRACER".

 LIENS CONNEXES 

・  P. 229 Couper les mêmes données à répétition

"MAUVAIS POSITION"

Les rouleaux-pinceurs se trouvent à des endroits où le matériau ne peut pas être pincé.

Appuyez sur n’importe quelle touche pour annuler la configuration et effacer le message d’erreur. Placez
les rouleaux-pinceurs dans les positions correctes et rechargez le matériau.

Si le message apparaît même si les rouleaux-pinceurs sont placés dans les positions correctes, la machine peut être ex-
posée à la lumière directe du soleil ou à un éclairage intérieur intense. Mettez la machine hors tension, puis placez-la
dans un endroit où elle ne sera pas exposée à la lumière directe du soleil ou à une lumière intense.

RAPPEL

Messages d’erreur
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Après avoir déplacé la machine, mettez-la sous tension.

 LIENS CONNEXES 

・  P. 29 Chargement du matériau plat

・  P. 35 Chargement du matériau en rouleau

"ERREUR MOTEUR"

Une charge lourde a été placée sur le moteur, et le fonctionnement s’est arrêté.

Lorsque la machine est surchargée dans les conditions suivantes, etc., "ERREUR MOTEUR" apparaît.

• La découpe a été effectuée avec un matériau épais chargé

• Le matériau a été arraché brusquement du rouleau pendant la coupe sans avoir été alimenté avant

• Le matériau était bloqué

Coupez l’alimentation, abaissez le levier de chargement et chargez à nouveau le matériau.

Coupe de matériau en rouleau

Tirez d’abord la longueur de matériau à découper du rouleau. En outre, effectuez un test d’alimentation
avant de couper.

Ce faisant, réglez une valeur d’environ 20 cm de plus que la longueur de coupe dans "AIRE" dans le menu
d’affichage.

Coupe de matériaux épais

Réglez le paramètre de qualité sur "LOURD".

"EEPROM ERROR"/"SOLENOID ERROR"

Mettez la machine hors tension et contactez votre revendeur Roland DG Corporation agréé.

Messages d’erreur
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La zone de coupe latérale du matériau (direction dans laquelle le chariot de coupe se déplace) est déter-
minée par la position des rouleaux-pinceurs. La zone de coupe s’étend entre les deux rouleaux-pinceurs,
moins environ 1 mm de chaque côté.

Rouleau-pinceur

Zone de découpe

Origine des coordonnées de coupe

A Max. 584 mm

B

Type de matériau spécifié

• "ROULEAU" / "BORD"
Max. 25 000 mm *1

• "FEUILLE"
Max. : Longueur détectée*2

C 10 à 25 mm

D Environ 1 mm

E 15 mm

F 50 mm ou plus

 

*1 La précision est garantie jusqu’à 1 600 mm.

*2 Si la longueur détectée est de 1 600 mm ou plus, le matériau est considéré comme "ROULEAU" et la longueur de la zone de
découpe est réglée sur environ 25 000 mm. Cependant, l’écran n’indique pas la longueur.

 

Zone de découpe
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Configurez les marges et la distance entre les repères de découpe. Prenez en compte la marge nécessaire
à la découpe du matériau et définissez la position du repère de découpe.

Impression de la zone avec des repères de découpe (lors de la création de
données de coupe avec CutStudio)

Assurez-vous que la zone où sont positionnés les repères de découpe n’ait pas d’illustration ou de saleté, et qu’il n’y ait
rien que les repères de découpe.

RAPPEL

Longueur (L) entre les repères de découpe

Largeur (W, width) entre les repères de découpe

Surface imprimable

A 500 mm ou moins

B 610 mm ou moins

C 10 à 60 mm *1

D 10 à 42,5 mm

E 50 mm ou plus

F 20 mm

 

*1 Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous utilisez du maté-
riau dans des formats autres que A3, A4 ou B4.

Marges et distance entre les repères de découpe
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• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins 30 mm (W) entre
l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de dégagement est inférieure à 30 mm, le
repère de découpe ne peut pas être lu.

 

 LIENS CONNEXES 

・  P. 67 Définir les conditions d’impression

Marges et distance entre les repères de découpe
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Impression de la zone avec des repères de découpe (lors de la création de
données de coupe avec Adobe Illustrator/CorelDRAW)

Assurez-vous que la zone où sont positionnés les repères de découpe n’ait pas d’illustration ou de saleté, et qu’il n’y ait
rien que les repères de découpe.

RAPPEL

Longueur (L) entre les repères de découpe

Largeur (W, width) entre les repères de découpe

Plage de découpe

A 1 500 mm ou moins

B Largeur du matériau

C 10 mm ou plus *1

D 10 mm ou plus

E 50 mm ou plus

F 20 mm

 

*1 Définissez manuellement les positions des repères de découpe. Tenez compte des points suivants quand vous utilisez des maté-
riaux dans des formats autres que A3, A4 ou B4.

• Quand vous utilisez un rouleau-pinceur dans la partie abrasive la plus à gauche, veillez à laisser au moins 30 mm (W) entre
l’extrémité gauche de la partie abrasive et le repère de découpe. Si la distance de dégagement est inférieure à 30 mm, le
repère de découpe ne peut pas être lu.

Marges et distance entre les repères de découpe
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 LIENS CONNEXES 

・  P. 101 Définir les conditions d’impression

・  P. 153 Définir les conditions d’impression

Marges et distance entre les repères de découpe
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Système d’entraînement Servomoteur à commande numérique

Mécanisme de coupe Méthode de déplacement des médias

Taille acceptable du ma-
tériau

Largeur 50 mm à 700 mm

Longueur Matériau en rouleau : aucune restriction
Matériau plat : 100 mm ou plus

Zone de découpe maximale 584 mm (Largeur) × 25 000 mm (Longueur)

Outils utilisables • Lame de la série CAMM-1 (ZEC-U5032 / U5022 / U5025 / U3017)
• Lame plate (ZEC-U1715 / U3050 / U3075 / U3100)
• Lame de film pour vitre (ZEC-U5010)

Vitesse de coupe 10 à 850 mm/s

Force de la lame 30 à 500 gf

Résolution mécanique 0,0125 mm/incrément

Résolution logicielle 0,025 mm/incrément

Précision de la distance*1 Erreur inférieure à ±0,2 % de la distance parcourue ou 0,1 mm, selon la plus
grande des deux valeurs

Répétabilité*1*2 0,1 mm ou moins

Précision de l’alignement pour l’impression et la
découpe lorsque le matériau imprimé est chargé*1*3

±1 mm ou moins pour une distance de déplacement de 210 mm ou moins dans
le sens de l’alimentation du matériau et une distance de déplacement de 170
mm ou moins dans le sens de la largeur (Sans tenir pas compte de l’influence
de l’imprimante et du matériau)

Connectivité • Ethernet (commutation automatique entre 10BASE-T et 100BASE-TX)
• USB 2.0 (conforme FULL SPEED)

Mémoire de tracé 2 Mo (taille de la mémoire tampon : 8 Mo)

Système de commande CAMM-GLⅢ

Alimentation électrique Adaptateur secteur dédié
Entrée : 100 - 240 VAC, 50/60 Hz
Sortie : 24 VCC 2,7 A

Courant nominal 1,0 A

Consommation d’énergie Environ 24 W

Niveau de bruit acousti-
que

Pendant le fonctionne-
ment

70 dB (A) ou moins

Pendant la mise en veille 40 dB (A) ou moins

Dimensions extérieures 860 mm (Largeur) × 319 mm (Profondeur) × 235 mm (Hauteur)

Poids de l’appareil 13,5 kg

Environnement • Température : 5 à 40 °C
• Humidité : 20 à 80 % HR (sans condensation)

Éléments inclus Cordon d’alimentation, Prise secteur, Lame, Porte-lame, Base du rouleau, Câ-
ble USB, Outil d’alignement, Manuels

 

*1 Selon le matériau et les conditions de coupe, comme spécifié par Roland DG Corporation.

*2 • Excluant l’expansion/contraction des médias
• Longueur dans le sens d’alimentation de la feuille : 1 600 mm max.

*3 Selon les normes de mesure spécifiées par Roland DG Corporation.

• Le logiciel doit être inclus dans le logiciel Roland DG Corporation.
• En supposant l’utilisation d’une imprimante laser ou à jet d’encre d’une résolution de 720 dpi ou plus.
• N’inclut pas les matériaux brillants et/ou laminés.
• N’inclut pas les effets de l’impression déformée due à la précision de l’imprimante ou les effets de l’expansion/contraction

du matériau.
• Peut ne pas être lu correctement par le capteur en fonction de l’encre d’imprimante (noire) utilisée.

 

Caractéristiques techniques
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Les noms de sociétés et de produits sont des marques commerciales ou des marques déposées de leurs dé-
tenteurs respectifs.

Rappel
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